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The Agilent 16760A Logic Analyzer—At a Glance

The Agilent Technologies 16760A is a 1500 Mb/s state, 800 MHz timing logic 

analyzer module for the Agilent Technologies 16700-series or 16900-series logic 

analysis system. The 16760A offers high performance measurement capability.

Features

Some of the main features of the 16760A are as follows:

• 32 data channels.

• 2 clock/data channels.

• 128 Mb memory depth per channel.

• 1500 MHz maximum state acquisition speed.

• 800 MHz maximum timing acquisition speed.

• Expandable to 170 channels.

Service Strategy

The service strategy for this instrument is the replacement of defective 

assemblies. This service guide contains information for finding a defective 

assembly by testing and servicing the 16760A state and timing analyzer module.

The modules can be returned to Agilent Technologies for all service work, 

including troubleshooting. Contact your nearest Agilent Technologies Sales 

Office for more details.

Application

This service guide applies to a 16760A module installed in 16700-series or 16900-

series logic analysis system mainframes. 

www.valuetronics.com
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In the 16700-series logic analysis system, the 16760A logic analyzer requires 

software version A.02.20.00 or higher. Agilent 16700-series mainframes with 

serial number prefixes lower than US4111 are factory-installed with older 

operating system versions.

In the 16900-series logic analysis system, the 16760A logic analyzer requires 

software version 03.20.0000 or higher.

If your logic analysis system software is older than the required version, contact 

your Agilent Technologies Service Center for newer software. Refer to 

“Mainframe and Operating System” on page 10 for more information.

The 16760A Logic Analyzer
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In This Book

This book is the service guide for the 16760A 1500 Mb/s state, 800 MHz timing 

logic analyzer module. 

This service guide has eight chapters.

Chapter 1, “General Information,” beginning on page 9 contains information 

about the module and includes accessories for the module, specifications and 

characteristics of the module, and a list of the equipment required for servicing 

the module.

Chapter 2, “Preparing for Use,” beginning on page 15 tells how to prepare the 

module for use. 

Chapter 3, “Testing Performance,” beginning on page 19 gives instructions on 

how to test the performance of the module.

Chapter 4, “Calibrating,” beginning on page 119 contains calibration instructions 

for the module (if required).

Chapter 5, “Troubleshooting,” beginning on page 121 contains explanations of 

self-tests and flowcharts for troubleshooting the module.

Chapter 6, “Replacing Assemblies,” beginning on page 171 tells how to replace 

the module and assemblies of the module and how to return them to Agilent 

Technologies.

Chapter 7, “Replaceable Parts,” beginning on page 179 lists replaceable parts, 

shows an exploded view, and gives ordering information.

Chapter 8, “Theory of Operation,” beginning on page 185 explains how the 

analyzer works.
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1

General Information

This chapter lists the accessories, the specifications and characteristics, and the 

recommended test equipment.

www.valuetronics.com



10   

Chapter 1: General Information

Accessories 

One or more of the following accessories, not supplied, are required to operate 

the 16760A logic analyzer. 

Mainframe and Operating System

In the 16700-series logic analysis system, the 16760A logic analyzer requires 

software version A.02.20.00 or higher. However, the specifications apply to 

operating system version A.02.60.00 or higher. The mainframe operating system 

must be upgraded to version A.02.60.00 before attempting the performance 

verification procedure in Chapter 3. Agilent 16700-series mainframes with serial 

number prefix lower than US4148 are factory-installed with operating system 

versions older than A.02.60.00.

In the 16900-series logic analysis system, the 16760A logic analyzer requires 

software version 03.20.0000 or higher.

If the proper system software version is not loaded, obtain a copy of the updated 

system software and install it in the logic analyzer mainframe. You can request a 

16700-series software upgrade at http://software.cos.agilent.com/16700, 

download the latest 16900-series software from http://www.agilent.com/find/

16900_SW_Download, or contact your nearest Agilent Technologies Customer 

Support Center.

Three Cooling Fans Required in 16700-Series Mainframe

Earlier versions of the 16700A/01A/02A mainframe contained only two cooling 

fans and might not provide adequate cooling to ensure reliable performance. If 

the first six digits of the 16700A/02A serial number (located on the back of the 

instrument) are US3849 or higher, or the first six digits of the 16701A are US3902 

or higher, the instrument is a three-fan model, which will supply sufficient 

cooling. 

Accessories Agilent Part Number

Single-ended soft touch probe E5390A

Differential soft touch probe E5387A

100-pin single-ended probe E5378A

100-pin differential probe E5379A

38-pin single-ended probe E5380A

Single-ended flying lead probe set E5382A

Differential flying lead probe set E5381A
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Chapter 1: General Information

All 16700B/01B/02B systems already have three cooling fans which provide 

adequate cooling to ensure reliable performance.

Specifications

The specifications are the performance standards against which the product is 

tested.

Setup/Hold Window:

Specifications for each input

Parameter

Minimum

Description/Notes1500 

Mb/s

1250 

Mb/s

800 Mb/

s

400 Mb/

s

200 Mb/

s

Data to

Clock 

tWidth* 500 ps 1.25 ns Eye width in system under test**

tSetup 250 ps 625 ps Data setup time required before tSample

tHold 250 ps 625 ps Data hold time required after tSample

*Specified for an input signal ≤ 800 mV peak-to-peak voltage swing 1V/ns slew rate, using an Agilent E5378A or E5382A probe.

**Eye width and height are specified at the probe tip. Eye width as measured by eye finder in the analyzer may be less.

tWidth

vHeight
Individual

Data Channel

tSample*

Clock Channel

vThreshold

0VSampling

Position

Data Eye

* User Adjustable

tSetup tHold

16760b05
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Chapter 1: General Information

Characteristics

The characteristics are not specifications, but are included as additional 

information.

Environmental Characteristics

Threshold Accuracy ±(30 mV+1.0% of threshold setting)

Speed/Depth/Channel Count Full Channel Half Channel

Maximum Conventional Timing Rate 400 MHz 800 MHz

Memory Depth 64 M 128 M

Channel Count per Card 34 17

Channel Count per Five-Card Module 170 85

Probes

Maximum Input Voltage ± 40 V, CAT I, CAT I = Category I, 

secondary power line isolated circuits.

Auxiliary Power

Power Through Cables 1/3 amp at +5 V maximum per cable.

Operating Environment

Temperature Instrument, 0 °C to 40 °C (+32 °F to 104 °F) when installed in a 

16900A or 16902A mainframe.

Instrument, 0 °C to 50 °C (+32 °F to 122 °F) when installed in a 

16903A or 16700-series mainframe.

Probe lead sets and cables, 0 °C to 65 °C (+32 °F to 149 °F).

Humidity Instrument, probe lead sets, and cables, up to 95% relative humidity at 

+40 °C (+122 °F). Non-condensing.

Altitude To 3000 m (10,000 ft).

Vibration Operating: Random vibration 5 to 500 Hz, 10 minutes per axis, 

≈0.2 g (rms).

Non-operating: Random vibration 5 to 500 Hz, 10 minutes per axis,

≈2.41 g (rms); and swept sine resonant search, 5 to 500 Hz, 0.5 g 

(0-peak), 5 minute resonant dwell at 4 resonances per axis.

Operating power supplied by mainframe.

Indoor use only.

Pollution Degree 2.
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Chapter 1: General Information

Recommended Test Equipment

Equipment Required

Equipment Critical Specifications
Recommended Agilent 

Model/Part
 Use

Probe Adapter no substitute E5378A P, T

Probe Adapter (Qty 2)* no substitute E5382A P, T

Ground Clips (Qty 10) no substitute 16517-82105 (pkg of 20) T

Stimulus Board no substitute 16760-60001 T

Pulse Generator 750 MHz, 666.6 ps pulse width, 

< 120 ps rise time

8133A Option 003 P, T

Digitizing Oscilloscope ≥11 GHz bandwidth, <31.8 ps rise time 54750A mainframe with 

54751A plug-in module

P

Test connectors** no substitute P

150 ps Transition Time 

Converters (Qty 4)

See page 22. Agilent or HP 15435A P

20:1 Probes (Qty 2) 54006A T

SMA Coax Cable (Qty 3) ≥ 18 GHz bandwidth 8120-4948 P

BNC Coax Cable BNC (m-m), >2 GHz bandwidth 8120-1840 P

Adapter SMA(m)-BNC(f) 1250-1200 P

P = Performance Tests, T = Troubleshooting

*For a multicard module, one probe adapter per card is required.

**Instructions for making these test connectors are in Chapter 3.
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Chapter 1: General Information
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2

Preparing for Use

This chapter gives you instructions for preparing the logic analyzer module for 

use.
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Chapter 2: Preparing for Use

Power Requirements

All power supplies required for operating the logic analyzer are supplied through 

the backplane connector in the mainframe.

Operating Environment

The operating environment is listed on page 12. Note the non-condensing 

humidity limitation. Condensation within the instrument can cause poor 

operation or malfunction. Provide protection against internal condensation.

The logic analyzer module will operate at all specifications within the 

temperature and humidity range given on page 12. However, reliability is 

enhanced when operating the module within the following ranges:

Temperature: +20 °C to +35 °C (+68 °F to +95 °F)

Humidity: 20% to 80% non-condensing

Storage

Store or ship the logic analyzer in environments within the following limits:

• Temperature: -40 °C to +75 °C (-40 °F to +167 °F).

• Humidity: Up to 90% at 65 °C.

• Altitude: Up to 15,300 meters (50,000 feet).

Protect the module from temperature extremes which cause condensation on the 

instrument.
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Chapter 2: Preparing for Use

To inspect the module

1 Inspect the shipping container for damage.

If the shipping container or cushioning material is damaged, keep them until you 

have checked the contents of the shipment and checked the instrument 

mechanically and electrically.

2 Check the supplied accessories.

One or more of the accessories listed on page 10 are required to operate the 

16760A logic analyzer module.

3 Inspect the product for physical damage.

Check the module and the supplied accessories for obvious physical or 

mechanical defects. If you find any defects, contact your nearest Agilent 

Technologies Sales Office. Arrangements for repair or replacement are made, at 

Agilent Technologies' option, without waiting for a claim settlement.

To configure and install the module

Instructions for configuring and installing the module into the mainframe can be 

found in the installation guide for the mainframe.

If you don’t have the installation guide for your mainframe, you can find the latest 

version on the Internet at www.agilent.com.

For example: to find the installation guide for a 16700B mainframe, go to 

www.agilent.com and enter “16700B installation guide” in the quick search box. 

Then, scroll down to “Manuals, Guides & Notifications” to find the 16700B-Series 

Logic Analysis Systems Installation Guide.

To test the module

The logic analyzer module does not require an operational accuracy calibration or 

adjustment. After installing the module, you can test and use the module.

• If you require a test to verify the specifications, see “Testing Performance” on 

page 19.

• If you require a test to verify correct module operation using software self-

tests, see “To run the self-tests” on page 126.

• If the module does not operate correctly, see “Troubleshooting” on page 121.

www.valuetronics.com
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Chapter 2: Preparing for Use

To clean the module

• With the mainframe turned off and unplugged, use a cloth moistened with a 

mixture of mild detergent and water to clean the rear panel.

• Do not attempt to clean the module circuit board.
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3

Testing Performance

This chapter tells you how to test the performance of the logic analyzer against 

the specifications.
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Chapter 3: Testing Performance

Overview

Overview

To ensure the logic analyzer is operating as specified, two kinds of tests are made:

• Software (self) tests.

• Manual performance tests.

The logic analyzer is considered performance-verified if all of the software tests 

and manual performance tests have passed. The procedures in this chapter 

indicate what constitutes a “Pass” status for each of the tests.

16900-Series vs. 16700-Series Mainframes

The module can be tested in either a 16900-series or 16700-series logic analysis 

system mainframe. In either case, the SMA/Flying Lead Test Connectors, the 

equipment required, and setup of the test equipment will be the same, except 

that the logic analyzer setup will differ. The general instructions for performance 

test begin on page 23 with instructions for assembling the test connectors. 

Instructions specific to testing the module in a 16900-series mainframe begin on 

page 40. Instructions specific to testing the module in a 16700-series mainframe 

begin on page 79.

Manual Performance Test Strategy

Only specified parameters are tested. The specifications for the 16760A logic 

analyzer define a minimum data eye width and a minimum clock interval at 

which data can be acquired.

The manual performance tests verify that the logic analyzer meets these 

specifications.

At each of the five acquisition modes, you test the minimum data eye width at the 

minimum clock interval, thereby testing both specifications at once.

The minimum clock interval is specified from active clock edge to active clock 

edge. All tests are performed while clocking data into the logic analyzer on both 

rising and falling edges of the clock (double edge clock), so the pulse generator 

test frequency is set to half of the acquisition speed.

Acquisition Mode: 200 Mb/s 400 Mb/s 800 Mb/s 1.25 Gb/s 1.5 Gb/s

Minimum clock interval,

active edge to active edge

5 ns 2.5 ns 1.25 ns 800 ps 667 ps

Minimum data pulse width 1.5 ns 1.5 ns 750 ps 750 ps 600 ps
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Chapter 3: Testing Performance

Overview

Eye finder is used to adjust the sampling position on every channel. Eye 

finder must be used to achieve minimum data eye width.

The test conditions defined in the manual test procedure ensure that the 

specified parameter is as good as or better than specification. No attempt is made 

to determine performance which is better than specification. Not all channels of 

the logic analyzer will be tested; rather a sample of channels is tested. A 

calibration laboratory may choose to elaborate on these tests and test all 

channels at their discretion.

One-Card Module

To perform a complete test on a one-card module, start at the beginning of the 

chapter and follow the test procedure.

Multi-Card Module

To perform a complete test on a multi-card module:

• Perform the software (self) tests (page 27) with the cards connected.

• Then, remove the multi-card module from the mainframe and configure each card as a 

one-card module. Install the one-card modules into the mainframe and perform the 

manual tests on each card.

• When the manual tests are complete, remove the one-card modules, reconfigure them 

into their original multi-card module configuration, reinstall it into the mainframe and 

perform the software (self) tests again.

For removal instructions see Chapter 6, “Replacing Assemblies,” beginning on 

page 171. For installation and configuration instructions see Chapter 2, 

“Preparing for Use,” beginning on page 15.

Test Interval

Test the performance of the module against specifications at two-year intervals.

Test Record Description

A performance test record for recording the results of each procedure is located 

at the end of this chapter.
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Chapter 3: Testing Performance

Overview

Test Equipment Required

Each procedure lists the recommended test equipment. You can use equipment 

that satisfies the specifications given. However, the procedures are based on 

using the recommended model or part number.

The following equipment is required for the performance test procedure.

Instrument Warm-Up

Before testing the performance of the module, warm-up the instrument and the 

test equipment for 30 minutes.

Equipment Qty Critical Specification Recommended Model/Part

Pulse Generator 1 ≥ 765 MHz, two channels, differential 

outputs, 150-180 ps rise/fall time (if 

faster, use transition time converters).

Agilent or HP 8133A option 003 

150 ps Transition Time Converter 4 Required if pulse generator’s rise time 

is less than 150 ps. (Pulse generator 

conditions: Voffset=1V, 

∆V=250 mV.)

Required for 8133A opt. 003.

Agilent or HP 15435A 

Oscilloscope 1 bandwidth ≥ 1.5 GHz, 

sampling rate ≥ 8 GSa/s

Agilent or HP 54845A/B or similar

SMA Coax Cable 2 >18 GHz bandwidth Agilent or HP 8120-4948

Flying Lead Probe Set 2 no substitute Agilent E5382A

Male BNC to Female SMA 

adapters

2 Cambridge Products CP-AD507 (ref: 

www.cambridgeproducts.com)

SMA/Flying Lead test connectors, 

(f) SMA to (f) SMA to Flying Lead 

Probe

4 no substitute See “Assemble the SMA/Flying Lead 

Test Connectors” on page 23

www.valuetronics.com
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Chapter 3: Testing Performance

Assemble the SMA/Flying Lead Test Connectors

Assemble the SMA/Flying Lead Test Connectors

The SMA/Flying Lead test connectors provide a high-bandwidth connection 

between the logic analyzer and the test equipment. The following procedure 

explains how to fabricate the four required test connectors.

Materials Required

1 Prepare the pin strip header:

a Cut or cleanly break a 2 x 2 section from the pin strip.

Material Qty Critical Specification Recommended Model/Part

SMA Board Mount Connector 8 Johnson 142-0701-801 (ref: 

www.johnsoncomponents.com)

Pin Strip Header 1 (will be 

separated)

.100" X .100" Pin Strip Header, 

right angle, pin length .230", two 

rows, .120" solder tails

3M 2380-5121TN or similar 2- row 

with 0.1” pin spacing

SMA 50 ohm terminators 2 Minimum bandwidth 2 GHz Johnson 142-0801-866 50 ohm 

Dummy Load Plug 

SMA m-m adapter 4 Johnson 142-0901-811 SMA Plug to 

Plug or similar

www.valuetronics.com
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Chapter 3: Testing Performance

Assemble the SMA/Flying Lead Test Connectors

b Trim about 1.5 mm from the pin strip inner leads and straighten them 

so that they touch the outer leads.

c Trim about 2.5 mm from the outer leads.

d Using a very small amount of solder, tack each inner lead to each outer 

lead at the point where they are touching.

solder
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Chapter 3: Testing Performance

Assemble the SMA/Flying Lead Test Connectors

2 Solder the pin strip to the SMA board mount connector:

a Solder the leads on the left side of the pin strip to the center conductor 

of the SMA connector as shown in the diagram below.

b Solder the leads on the right side of the pin strip to the inside of the 

SMA connector’s frame as shown in the diagram below. Use a small 

amount of solder.

3 Attach the second SMA board mount connector:

a Re-heat the solder connection made in the previous step, and attach 

the second SMA connector, as shown in the diagram below. Note that 

the second SMA connector is upside-down, compared to the first. Add a 

little solder to make a good connection.

b Solder the center conductor of the second SMA connector to the center 

conductor of the first SMA connector and the leads on the left side of 

the pin strip.

c Rotate the assembly 180 degrees and solder the two SMA board mount 

connector frames together.

solder
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Chapter 3: Testing Performance

Assemble the SMA/Flying Lead Test Connectors

4 Check your work:

a Ensure that the following four points have continuity between them: 

The two pins on the left side of the pin strip, and the center conductors 

of each SMA connector.

b Ensure that there is continuity between each of the two pins on the 

right side of the pin strip, and the SMA connector frames.

c Ensure that there is NO continuity between the SMA connector center 

conductor and the SMA connector frame (ground).

5 Finish creating the test connectors:

a Attach an SMA m-m adapter to one end of each of the four SMA/Flying 

Lead test connectors.

b Attach a 50 ohm terminator to the other end of just two of the SMA/

Flying Lead test connectors.
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Chapter 3: Testing Performance

Run the Software (Self) Tests

Run the Software (Self) Tests

On a 16900-Series Mainframe

Use the following instructions to test the module using a 16900-series mainframe. 

If you are using a 16700-series mainframe, use the instructions beginning on 

page 29.

1 Record the 16760A logic analyzer’s model and serial number in the 

Performance Test Record (see page 118). Record your work order number 

(if applicable) and today’s date.

2 Record the test equipment information in the “Test Equipment Used” 

section of the Performance Test Record.

3 Turn on the logic analysis system.

NOTE: Before testing the performance of the module, warm-up the logic analyzer and 

the test equipment for 30 minutes.

a Connect the keyboard and monitor to the rear panel of the logic 

analysis mainframe (16900A only).

b Connect the mouse to the rear panel of the mainframe.

c Plug in the power cord to the power connector on the rear panel of the 

mainframe.

d Turn on the main power switch on the mainframe front panel.

While the logic analysis system is booting, observe the boot dialogue for the 

following:

• Ensure all of the installed memory is recognized.

• Any error messages.

• Interrupt of the boot process with or without error message.

4 During initialization, check for any failures.

If an error or an interrupt occurs, refer to the Agilent Technologies 16900A-

Series Logic Analysis System Service Guide for troubleshooting information.
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Chapter 3: Testing Performance

Run the Software (Self) Tests

5 Do a self-test on the 16900-series logic analysis system.

a When the logic analysis system has finished booting, the Waveform 

window appears. Choose “Help>Self-Test...” from the main menu. The 

Analysis System Self Tests dialog appears.

b In the Select Suite(s) list, select <all>. This will cause <all> to be 

selected in the Select Test(s) list.

c Click “Start”. This will perform a complete system self-test.

The progress of the self tests is displayed in the Progress & Statistics area of 

the window.

d When the self-tests are complete, check the Results window to ensure 

that the Result Summary says that all tests passed. If all tests did not 

pass, refer to “Troubleshooting” on page 121.

e Click “Close” to close the Analysis System Self Tests dialog.

f If all module self-tests pass, then record “PASS” in the “Logic Analysis 

System Self-Tests” section of the Performance Test Record (page 118).
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Chapter 3: Testing Performance

Run the Software (Self) Tests

On a 16700-Series Mainframe

1 Turn on the logic analysis system.

a Connect the keyboard and monitor to the rear panel of the logic 

analysis mainframe (16700B only).

b Connect the mouse to the rear panel of the mainframe.

c Plug in the power cord to the power connector on the rear panel of the 

mainframe.

d Turn on the main power switch on the mainframe front panel.

While the logic analysis system is booting, observe the boot dialogue for the 

following:

• ensure all of the installed memory is recognized

• any error messages

• interrupt of the boot process with or without error message

A complete transcript of the boot dialogue is in the Agilent Technologies 

16700B-series Logic Analysis System Service Guide, Chapter 8, "Theory of 

Operation.”

2 During initialization, check for any failures.

If an error or an interrupt occurs, refer to the Agilent Technologies 16700B-series 

Logic Analysis System Service Guide, Chapter 5, "Troubleshooting.” Note that if 

an Agilent 16760A module is temporarily installed in a mainframe only to test the 

performance of the module, then the mainframe may report that the module will 

require an operational accuracy calibration. This is expected, and step 4 in this 

procedure will clear this error message.

3 Do a self-test on the logic analysis system.

a When the logic analysis system has finished booting and the System 

window appears (that is, a session has started), click on the System 

Administration icon.

b Under the Admin tab, click on Self-Test... in the query pop-up, select 

Yes to exit the current session.

The Self-Test closes the current session because the test algorithms leave the 

system in an unknown state. Re-launching the session at the end of the self-

test will ensure the system is properly initialized.

c In the Self-Test window select Test All.
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Chapter 3: Testing Performance

Run the Software (Self) Tests

When the tests are finished, the Status will change to Passed or Failed. You 

can find detailed information about the test results in the Status Message field 

of the Self-Test window.

Some system CPU board tests may return a status of Untested because they 

require user action. Procedures to do these tests are found in the Agilent 

Technologies 16700B-series Logic Analysis System Service Guide. For the 

purposes of testing the Agilent 16760A module performance, running 

untested system CPU board tests are not required. If these tests are not done, 

the Agilent 16760A performance test is not affected.

d When the self-tests are complete, select Quit to exit the test menu.

e Record a PASS in the Performance Test Record if all module self-tests 

pass.

4 Set up the logic analysis system.

a In the Session Manager window, select "Start Session" to re-launch a 

logic analysis session.

b In the Logic Analysis System window, select the module icon, then 

select Setup and Trigger. A Setup and Trigger window will appear.

c In the Setup and Trigger window, click on the Calibration tab. Follow 

the instructions under the Calibration tab to perform an operational 

accuracy calibration on the Agilent 16760A module.

Repeat the above step for each single-card Agilent 16760A module installed in 

the mainframe that is being tested. If any calibration status returns "failed," 

then the Agilent 16760A module requires repair. If the calibration status 

returns "passed" for both pods, then record a PASS in the performance test 

record at the end of this chapter.

d Proceed to the next section when the operational accuracy calibration 

is complete.
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Initialize the Test Equipment for Manual Tests

1 Turn on the required test equipment. Let all of the test equipment and the 

logic analyzer warm up for 30 minutes before beginning any test.

2 Set up the pulse generator.

a Set the frequency of the pulse generator. We will test in the 200 Mb/s 

mode first.

The logic analyzer will be tested using a double-edge clock. The test 

frequency is half the test clock rate because data is acquired on both the rising 

edge and the falling edge of the clock. Set the frequency to 100 MHz plus the 

frequency uncertainty of the pulse generator, plus a test margin of 1%.

For example, if you are using an 8133A pulse generator, the frequency 

accuracy is ±1% of setting. Use a test margin of 1%. Set the frequency to 

100 MHz plus 2% (102 MHz).

b Set the rest of the pulse generator parameters to the values shown in 

the following table.

Pulse Generator Setup

Timebase Pulse Channel 2 Trigger Pulse Channel 1

Mode: Int Mode: Pulse ÷ 1 Disable (LED on) Mode: Square

Freq: was set in 

previous step.

Delay: (not available in pulse mode) Delay: 0 ps

Width: Initially set to 1.5 ns. 

Change later (on page 38).

Width: (not available in square 

mode)

Ampl: 0.25 V Ampl: 0.25 V

Offs: 1.0 V Offs: 1.0 V

Output: Enable (LED off) Output: Enable (LED off)

Comp: Normal (LED off) Comp: Normal (LED off)

Limit: Off (LED off) Limit: Off (LED off)

Output: Enable (LED off) Output: Enable (LED off)
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3 Set up the oscilloscope.

a Set up the oscilloscope according to the following tables.

Oscilloscope Setup

Setup: Channel 1 Setup: Ch. 1 Probe Setup: Channel 2 Setup: Ch. 2 Probe

On Attenuation: 1.00:1 On Attenuation: 1.00:1

Scale: 50 mV/div Units: Volts Scale: 50 mV/div Units: Volts

Offset: 1 V Attenuation Units: Ratio Offset: 1 V Attenuation Units: Ratio

Coupling: DC External Gain: (n/a) Coupling: DC External Gain: (n/a)

Input: 50 ohm Skew: (Set later. See 

page 37)

Input: 50 ohm Skew: 0.0 seconds

External Offset: (n/a) External Offset: (n/a)

Setup: Channel 3 Setup: Channel 4

Off Off

Setup: Horizontal Setup: Trigger Setup: Acquisition Setup: Display

Scale: 500 ps/div Mode: Edge Sampling Mode: Equiv. Time Waveforms: Connect dots

Position: 800 ps Source: Channel 1 Memory Depth: Automatic Persistence: Minimum

Reference: Center Level: 1.00 V Averaging: Enabled Grid: On (and set intensity)

Delayed: not selected Edge: Rising Edge # of Averages: 4 Backlight Saver: as 

preferred

Sweep: Auto

Measure: Markers

Mode: Manual placement

All else: (n/a)
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Connect the Test Equipment for Manual Tests

Connect the 16760A Logic Analyzer Pod to the 8133A Pulse 

Generator

1 Connect a Transition Time Converter (if required—see page 22) to each of 

the four outputs of the 8133A pulse generator: Channel 1 OUTPUT, 

Channel 1 OUTPUT, Channel 2 OUTPUT, Channel 2 OUTPUT.

2 Connect the two SMA/Flying Lead test connectors (see “Assemble the 

SMA/Flying Lead Test Connectors” on page 23) with 50 ohm terminators 

to the Transition Time Converters at the 8133A pulse generator Channel 1 

OUTPUT and Channel 1 OUTPUT. (If Transition Time Converters are not 

required, connect the SMA/Flying Lead test connectors directly to the 

pulse generator outputs.)

3 Connect the two SMA/Flying Lead test connectors without 50 ohm 

terminators to the Transition Time Converters at the 8133A pulse 

generator Channel 2 OUTPUT and Channel 2 OUTPUT. (If Transition Time 

Converters are not required, connect the SMA/Flying Lead test connectors 

directly to the pulse generator outputs.)

4 Connect an E5382A Flying Lead Probe Set to Pod 1 of the 16760A logic 

analyzer.
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5 Connect the E5382A Flying Lead Probe Set’s CLK lead to the pin strip of 

the SMA/Flying Lead connector at the 8133A pulse generator’s Channel 1 

OUTPUT.

NOTE: Be sure to use the black ground clip (supplied with the E5382A Flying Lead 

Probe Set) and orient the leads so that the black clip is connected to one of the 

SMA/Flying Lead connector’s ground pins!

6 Connect the E5382A Flying Lead Probe Set’s CLK lead to the SMA/Flying 

Lead connector at the 8133A pulse generator’s Channel 1 OUTPUT. Again, 

be sure to use the black ground clip and orient the leads so that the black 

clip is connected to ground.

7 Connect the E5382A Flying Lead Probe Set’s bits 6 and 14 to the SMA/

Flying Lead test connector’s pin strip connector at the 8133A pulse 

generator’s Channel 2 OUTPUT.

8 Connect the E5382A Flying Lead Probe Set’s bits 2 and 10 to the SMA/

Flying Lead test connector’s pin strip connector at the 8133A pulse 

generator’s Channel 2 OUTPUT.

ground clip
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Connect the 8133A Pulse Generator Output to the 54845A 

Oscilloscope

1 Attach Male BNC to Female SMA adapters to Channels 1 and 2 on the 

54845A oscilloscope.

2 Attach one end of an SMA cable to the Male BNC to Female SMA adapter 

on Channel 1 of the oscilloscope.

3 Attach the other end of the SMA cable to the SMA/Flying Lead connector 

at the Channel 2 OUTPUT of the 8133A pulse generator.

4 Attach one end of the other SMA cable to the Male BNC to Female SMA 

adapter on Channel 2 of the oscilloscope.

5 Attach the other end of the SMA cable to the SMA/Flying Lead connector 

at the Channel 2 OUTPUT of the 8133A pulse generator.

www.valuetronics.com



36   

Chapter 3: Testing Performance

Set Up the Test Equipment for Manual Tests

Set Up the Test Equipment for Manual Tests

Next, verify and adjust the pulse generator’s DC offset, deskew the oscilloscope, 

and measure and adjust the pulse width.

Verify and Adjust the 8133A Pulse Generator DC Offset

1 On the 54845A oscilloscope, select Measure from the menu bar at the top 

of the display.

2 Select Markers...

3 In the Markers Setup window set marker “Ay” to 0.875 V, and set marker 

“By” to 1.125 V.

4 Observe the waveforms on the oscilloscope display. If they are not 

centered within the “Ay” and “By” markers, adjust the 8133A pulse 

generator’s Channel 2 OFFSET until the waveforms are centered as well as 

possible. (The resolution of the 8133A OFFSET setting is 20 mV.)

www.valuetronics.com



 37

Chapter 3: Testing Performance

Set Up the Test Equipment for Manual Tests

Deskew the Oscilloscope

This procedure neutralizes any skew in the oscilloscope’s waveform display.

1 On the 54845A oscilloscope, change the Horizontal scale from 500 ps/div 

to 200 ps/div. You can do this using the large knob in the Horizontal setup 

section of the front panel.

2 Select Setup from the menu bar at the top of the oscilloscope display.

3 Select Channel 1.

4 Select Probes.

NOTE: If the Probes dialog obscures the waveform display, select Utilities, User 

Preferences..., and in the Dialog section choose Transparent. Then position the 

Probes dialog so you can see the horizontal crossings of the waveforms.
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5 Select Skew </> to deskew Channel 1 and Channel 2 signals so that both 

channels cross the 54845A horizontal center line at the same time, at both 

ends of the eye (both crossings of the horizontal center line). The 

horizontal center of the graticule line is at 1 volt because the vertical offset 

was set to 1 volt in the oscilloscope setup described on page 32.

6 Select Close in the Probe Setup window.

7 Select Close in the Channel Setup window.

Adjust the Measured Pulse Width to 1.5 ns

The pulse generator’s pulse width was set to 1.5 ns (in the setup on page 31). In 

this procedure, you will use the oscilloscope’s measurement markers to measure 

the actual pulse width in the test setup. Then you will adjust the pulse generator 

so that the measured pulse width is as specified.

1 Observe the 54845A oscilloscope display. Change the Channel 2 pulse 

width of the 8133A pulse generator so that the pulse width measured at 1 

volt on the oscilloscope is equal to 1.5 ns minus the measurement 
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uncertainty and display resolution of the oscilloscope, further reduced by 

35 ps for test margin.

For example, if you are using the 54845A/B oscilloscope, the measurement 

uncertainty is ±((0.007% * ∆t) + (full scale/2x memory depth) + 30 ps) ≅ ±30 ps. 

Add 5 ps for display resolution. Add 35 ps test margin.

1500 ps - 30.15 ps - 5 ps - 35 ps = 1430 ps

Therefore, set the pulse width as measured on the 54845A/B oscilloscope to 

1430 ps.

2 On the oscilloscope, move the Ax and Bx markers to the crossing points of 

the pulse and the horizontal center line. Read the pulse width at the 

bottom of the oscilloscope display. It is displayed as “∆=”.
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Manual Test Procedure, 16900-Series Mainframe

The steps that follow include pass/fail criteria.

Test Pod 1 in 200 Mb/s Mode

1 Configure the logic analyzer:

a In the Agilent Logic Analyzer application, choose “File>New” to put 

the logic analysis system into its initial state.

b Disable all logic analyzers other than the analyzer under test.

i Select the Overview tab at the bottom of the main window.

ii Click on each unused logic analyzer and select disable. Only the logic 

analyzer to be tested should remain enabled.

c Set up threshold voltages and a bus name for the probed signals.

i Click the  Bus/Signal Setup icon.

ii In the Analyzer Setup dialog, click the Threshold button for Pod 1.

NOTE: The E5382A probe must be connected to the logic analyzer pod as described on 

page 33.
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iii In the Threshold Settings dialog, set the threshold value for Pod 1 of the 

16760A logic analyzer to “1 V”. Also, check “Apply setting to all pods” to 

properly set the threshold voltage for Pod 2, and uncheck “Apply settings 

to clock bits” (because the clock input threshold will be set to 

“differential” in a later step).

iv Click “OK” to close the Threshold Settings dialog. Now, in the Analyzer 

Setup dialog, the activity indicators for Pod 1 show activity on the 

channels that are connected to the pulse generator.

v Un-assign all channels (hint: you can do this quickly by clicking on the 

left-most check mark and dragging to the right across all of the other 

check marks — if you have a model 16902A or 16903A logic analysis 

system mainframe you can touch the touchscreen and drag across with 

your finger) and re-assign Pod 1 channels 2, 6, 10, and 14 to the 

“My Bus 1” bus.

vi Drag the scroll bar all the way to the left and click the “Clock” threshold 
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button.

vii In the Threshold Settings - Clocks dialog, click the threshold button 

associated with the Pod 1 clock.

viii In the Threshold Settings for Pod 1 dialog, select “Differential”.

ix Click “OK” to close the Threshold Settings dialogs. Now, in the Analyzer 

Setup dialog, the activity indicator for the Pod 1 clock shows activity.

d Set the sampling mode:

i Click the “Sampling” tab in the Analyzer Setup dialog.

ii Select the “State - Synchronous Sampling” Acquisition mode.

iii Set the Trigger Position to “100% poststore”.

iv Set the Acquisition Depth to “128K”.

v Select the “200 Mb/s” Sampling Option.
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vi Select “Both Edges” for Pod1 Clk1.

2 Adjust sampling positions using eye finder:

a In the Analyzer Setup dialog’s Sampling tab, click “Thresholds and 

Sample Positions...”.

b In the Thresholds and Sample Positions dialog, expand the “My Bus 1” 

bus name so you can see the individual signals in the bus.

c If the blue bars in the eye finder display are not vertically aligned:

i Grab the right-most blue bar in the “My Bus 1” row with the mouse 

pointer and move it all the way to the left and release the mouse button. 

This will vertically align all of the blue bars.

d Using the mouse pointer, grab the blue bar for “My Bus 1” and move it 

to the recommended starting position of 0.6 ns. All of the blue bars will 

follow.

e Click “Run” (the green button in the lower left-hand corner of the 

dialog).

f Ensure that an eye appears for each bit near the recommended starting 

position. Depending on your test setup, the eye position may vary. Any 

skew between channel 1 and channel 2 of your pulse generator will 

cause the eye position to shift to the left or right in the eye finder 

display. A shift of up to 0.5 ns should be considered normal. The 

important point is that your eye finder display should look similar to 
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the picture below (although it may be shifted left or right), and eye 

finder must be able to place the blue bars in the narrow eye.

g Re-align any stray channels if necessary. See page 45.
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Re-Aligning a Stray Channel

If the blue bar for a particular bit does not appear in its eye near the recommended starting position, you 
need to re-align the sampling position of the stray channel. In the following example, the sampling position of 
one channel (My Bus 1[2]) must be re-aligned with the sampling position of the other channels. (The 
following example shows the analyzer in the 1500 Mb/s mode.)

Using the mouse, drag the sample position (blue line) of a stray channel so that it is in the same eye as the 
other channels (drag channel My Bus 1[2] in the above example). The suggested position from eye finder 
(green triangle) will also move to the new eye. Do this for all remaining stray channels.

Click “Run”. Eye finder will recalculate the new sample positions based on the sample position changes. The 
following example shows all sampling positions aligned and in the correct eye (with the analyzer in the 
1500 Mb/s mode).
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3 Determine PASS/FAIL (1 of 2 tests):

a PASS/FAIL: If an eye exists near the recommended starting position for 

every bit, and eye finder places a blue bar in the eye for each bit, then 

the logic analyzer passes this portion of the test.

b If an eye does not exist near the recommended starting position for 

every bit or eye finder cannot place the blue bar in the eye, then the 

logic analyzer fails the test. Record the failure in the test record (shown 

on page 118).

4 In the Listing window, set up the logic analyzer to trigger on the value “A”, 

and click the  Run icon.

5 Set up a marker to search for the appropriate number of A’s or 5’s:

a From the main menu, choose “Marker>New...”.

b In the New Marker dialog’s Position box, select “Value” and from 

“Beginning Of Data”.
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c Click “Occurs...”.

d In the Value dialog, enter “131072” occurrences (the decimal equivalent 

of 128K samples) of the bus value “A” or “5” when “Present”.

e Click “Properties...”.

f In the Value Properties dialog, select when value “is not found”, “Stop 

repetitive run”.

g Click “OK” to close the Value Properties, Value, and New Marker 

dialogs.

6 Determine PASS/FAIL (2 of 2 tests):

Pass/Fail Point: The Listing window is set up to search for the appropriate 

number of A's and 5's in the acquisition. If the logic analyzer does not detect the 

correct number of A’s and 5’s, an error window will appear.

a Click the  Run Repetitive icon. Let the logic analyzer run for about 

one minute.

The logic analyzer acquires data, and the Listing window will continuously 

updates. Each time the logic analyzer runs, you see the value marker 

searching for the specified number of occurrences.
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If the “can’t find occurrence” dialog appears, the logic analyzer fails the test.

Check your test setup. If the failure is not the result of a problem with the test 

setup, record the failure in the appropriate place on the Performance Test 

Record.

NOTE: Be sure that the black ground clip is making good contact with the ground pin on 

the test connector.

b After about one minute, click the  Stop icon to stop the acquisition.

If the “can’t find occurrence” dialog does not appear, the logic analyzer passes 

the test. Record “Pass” in the appropriate place on the Performance Test 

Record.

NOTE: As a point of curiosity, you may want to determine the absolute minimum pulse 

width and/or absolute maximum frequency at which data can be acquired. The 

“Performance Test Record” on page 118 does not include places for recording 

these values because the Performance Verification procedure only verifies that 

the logic analyzer meets specifications. Determination of additional parameters is 

not required, but may be performed at the discretion of the calibration laboratory.

On some pulse generators, the signal outputs may become slightly unstable for a 

very short period of time when the signal parameters are adjusted. Adjusting the 

pulse generator while the logic analyzer is running can cause a false failure.

If the error message is displayed immediately after making an adjustment to the 

pulse generator, click “OK” to close the error dialog, and re-run the logic analyzer.

7 Test the complement of the bits:

a On the 8133A pulse generator, in the PULSE setup for CHANNEL 2, 

select COMP.

b Note that the signal on the oscilloscope has moved. Change the 

oscilloscope’s horizontal position to -600 ps (or as required) to center 

the measured pulse on the oscilloscope display.

c Verify the DC offset and adjust it if necessary. See page 36.

d Deskew the oscilloscope if necessary. See page 37.
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e Adjust the oscilloscope’s measurement markers to measure the pulse 

width. Set the markers so that ∆=1430 ps (this assumes you are using 

the 8133A pulse generator and the Infiniium oscilloscope). Adjust the 

pulse generator so that the pulse width is 1430 ps as measured by the 

markers. See page 38 for details.

f Adjust the sampling positions (run eye finder). See page 43.

g Determine pass or fail (1 of 2 tests). See page 46.

h Click the  Run Repetitive icon.

i Determine pass or fail (2 of 2 tests). See page 47.
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Test Pod 2 in 200 Mb/s Mode

1 Change test equipment connections:

a Leave the first E5382A Flying Lead Probe Set connected to Pod 1 of the 

logic analyzer. Remove the Pod 1 flying leads 2, 6, 10, and 14 from the 

SMA/Flying Lead test connectors. Do not remove the flying leads that 

are connected to CLK and CLK.

b Connect the second E5382A Flying Lead Probe Set to Pod 2 of the logic 

analyzer.

c Connect the Pod 2 E5382A Flying Lead Probe Set’s bits 6 and 14 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

d Connect the Pod 2 E5382A Flying Lead Probe Set’s bits 2 and 10 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

2 On the 8133A pulse generator, in the PULSE setup for CHANNEL 2, press 

the COMP button to return the outputs to normal.

3 Note that the signal on the oscilloscope has moved. Change the 

oscilloscope’s horizontal position to 800 ps (or as required) to center the 

measured pulse on the oscilloscope display.

4 Verify the DC offset and adjust it if necessary. See page 36.

5 Deskew the oscilloscope if necessary. See page 37.

6 Re-adjust the pulse width from the pulse generator as measured on the 

oscilloscope to 1.5 ns. See page 38.

7 Re-assign bits to “My Bus 1”:

a Click the  Bus/Signal Setup icon.
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b In the Analyzer Setup dialog’s Buses/Signals tab, re-assign the 

“My Bus 1” bus name to bits 2, 6, 10, and 14 of Pod 2.

(The threshold voltages for Pod 2 and the Pod 1 clock were previously set up 

to “1 V” and “differential”, respectively.)

c Click “OK” to close the Analyzer Setup dialog.

8 Adjust the sampling positions using eye finder. Be sure to expand 

“My Bus 1” and use the recommended starting position noted on page 43. 

Re-align any stray channels if necessary. See page 45.

9 Determine pass or fail (1 of 2 tests). See page 46.

10 Click the  Run Repetitive icon.

11 Determine pass or fail (2 of 2 tests). See page 47.

12 Test the complement of the bits. See page 48.
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Test Pod 1 in 400 Mb/s mode

1 Change test equipment connections:

a Disconnect the Pod 2 E5382A Flying Lead Probe Set’s bits 2, 6, 10, and 

14 from the SMA/Flying Lead test connectors’ pin strip connectors.

The original E5382A Flying Lead Probe Set should still be connected to Pod 1. 

The Pod 1 clock will be used for all tests.

b Connect the Pod 1 E5382A Flying Lead Probe Set’s bits 6 and 14 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

c Connect the Pod 1 E5382A Flying Lead Probe Set’s bits 2 and 10 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

2 On the 8133A pulse generator, in the PULSE setup for CHANNEL 2, press 

the COMP button to return the outputs to normal.

3 Note that the signal on the oscilloscope has moved. Change the 

oscilloscope’s horizontal position to 800 ps (or as required) to center the 

measured pulse on the oscilloscope display.

4 Verify the DC offset and adjust it if necessary. See page 36.

5 Set the frequency of the pulse generator. The logic analyzer will be tested 

using a double-edge clock. The test frequency is half the test clock rate 

because data is acquired on both the rising edge and the falling edge of the 

clock. Set the frequency to 200 MHz plus the frequency uncertainty of the 

pulse generator, plus a test margin of 1%.

For example, if you are using an 8133A pulse generator, the frequency accuracy 

is ±1% of setting. Use a test margin of 1%. Set the frequency to 200 MHz plus 2% 

(204 MHz).

6 Verify the oscilloscope Deskew and adjust if necessary. See page 37.

7 Adjust the measured pulse width from the pulse generator to 1.5 ns 

(minus the test margin) as described on page 38.

8 Change the sampling option:

a Click the  Sampling Setup icon.

b In the Analyzer Setup dialog’s Sampling tab, select the “400 Mb/s” 

Sampling Option.
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c Click “OK” to close the Analyzer Setup dialog.

9 Change the logic analyzer pod assignment to use Pod 1:

a Choose “Setup>(logic analyzer module name)>Pod Assignment...”.

b In the Pod Assignment dialog, select the logic analyzer module name for 

Pod 1 and “Reserved for time tag storage” for Pod 2.

c Click “OK” to close the Pod Assignment dialog.

10 Re-assign bits to “My Bus 1”:

a Click the  Bus/Signal Setup icon.

b In the Analyzer Setup dialog’s Buses/Signals tab, re-assign the 

“My Bus 1” bus name to bits 2, 6, 10, and 14 of Pod 1.

(The threshold voltages for Pod 1 and the Pod 1 clock were previously set up 

to “1 V” and “differential”, respectively.)
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c Click “OK” to close the Analyzer Setup dialog.

11 Adjust sampling positions using eye finder:

a Click the  Sampling Setup icon.

b In the Analyzer Setup dialog’s Sampling tab, make sure “Rising Edge” is 

selected for Pod1 Clk1.

c Click “Thresholds and Sample Positions...”.

d In the Thresholds and Sample Positions dialog, expand the “My Bus 1” 

bus name so you can see the individual signals in the bus.

e Grab the blue bar for “My Bus 1” and move it to approximately 0.9 ns. 

All blue bars will follow.

f Click “Run” (the green button in the lower left-hand corner of the 

dialog).

Note the average sampling position chosen by eye finder:______ns.

In the following example, the average sampling position is 0.83 ns. The 

position may be different based on your test setup.
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Note that in this step, you place the blue bars in the first narrow window (not 

the wide window) that appears to the right of zero in the eye finder display.

g Bring stray channels into alignment if necessary. See page 45.

h Click “OK” to close the Thresholds and Sample Positions dialog.

i Now, select “Both Edges” for Pod1 Clk1.

j Click “Thresholds and Sample Positions...”.

k In the Thresholds and Sample Positions dialog, align the blue bars 

vertically. See page 43.

l Grab the blue bar for “My Bus 1” and move it to the recommended 

starting position you noted in the prior step.

m Click “Run” (the green button in the lower left-hand corner of the 

dialog) again.

Some eyes may close, but the eyes in the sampling position you chose on 

page 54 should remain open.

12 Perform the procedure “Determine PASS/FAIL (1 of 2 tests):” on page 46.
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13 Make sure the logic analyzer is set up for testing data acquisition:

a In the Listing window, make sure the logic analyzer is set up to trigger 

on My Bus 1 value “A”.

b Click the  Run icon.

c Make sure the search marker is set up to search for 131072 occurrences 

of A’s or 5’s. See page 46.

14 Click the  Run Repetitive icon.

15 Perform the procedure “Determine PASS/FAIL (2 of 2 tests):” on page 47.

16 Test the complement of the bits:

a On the 8133A pulse generator, in the PULSE setup for CHANNEL 2, 

select COMP.

b Note that the signal on the oscilloscope has moved. Change the 

oscilloscope’s horizontal position to -600 ps (or as required) to center 

the measured pulse on the oscilloscope display.

c Verify the DC offset and adjust it if necessary. See page 36.

d Deskew the oscilloscope. See page 37.

e Verify that the pulse width is set to 1.5 ns. See page 38.

f Run eye finder.

g Perform the procedure “Determine PASS/FAIL (1 of 2 tests):” on 

page 46.

h Click the  Run Repetitive icon.

i Perform the procedure “Determine PASS/FAIL (2 of 2 tests):” on 

page 47.
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Test Pod 2 in 400 Mb/s mode

1 Change test equipment connections:

a Leave the first E5382A Flying Lead Probe Set connected to Pod 1 of the 

logic analyzer. Remove the Pod 1 flying leads 2, 6, 10, and 14 from the 

SMA/Flying Lead test connectors. Do not remove the flying leads that 

are connected to CLK and CLK flying leads.

b Connect the Pod 2 E5382A Flying Lead Probe Set’s bits 6 and 14 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

c Connect the Pod 2 E5382A Flying Lead Probe Set’s bits 2 and 10 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

2 On the 8133A pulse generator, in the PULSE setup for CHANNEL 2, press 

the COMP button to return the outputs to normal.

3 Note that the signal on the oscilloscope has moved. Change the 

oscilloscope’s horizontal position to 800 ps (or as required) to center the 

measured pulse on the oscilloscope display.

4 Verify the DC offset and adjust it if necessary. See page 36.

5 Deskew the oscilloscope if necessary. See page 37.

6 Adjust the measured pulse width from the pulse generator to 1.5 ns 

(minus the test margin) as described on page 38.
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7 Change the logic analyzer pod assignment to use Pod 2:

a Choose “Setup>(logic analyzer module name)>Pod Assignment...”.

b In the Pod Assignment dialog, select “Reserved for time tag storage” for 

Pod 1 and the logic analyzer module name for Pod 2.

c Click “OK” to close the Pod Assignment dialog.

8 Re-assign bits to “My Bus 1”:

a Click the  Bus/Signal Setup icon.

b In the Analyzer Setup dialog’s Buses/Signals tab, re-assign the 

“My Bus 1” bus name to bits 2, 6, 10, and 14 of Pod 2.

(The threshold voltages for Pod 2 and the Pod 1 clock were previously set up 

to “1 V” and “differential”, respectively.)

c Click “OK” to close the Analyzer Setup dialog.
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9 Adjust the sampling positions using eye finder. Be sure to expand 

“My Bus 1”. Use the starting position you noted on page 54. Re-align any 

stray channels if necessary. See page 45.

10 Determine pass or fail (1 of 2 tests). See page 46.

11 Make sure the logic analyzer is set up for testing data acquisition:

a In the Listing window, make sure the logic analyzer is set up to trigger 

on My Bus 1 value “A”.

b Click the  Run icon.

c Make sure the search marker is set up to search for 131071 occurrences 

of A’s or 5’s. See page 46.

12 Click the  Run Repetitive icon.

13 Determine pass or fail (2 of 2 tests). See page 47.

14 Test the complement of the bits on Pod 2. You can use the procedure “Test 

the complement of the bits:” on page 56 as a guideline.

Test Pod 1 in 800 Mb/s mode

1 Change test equipment connections:

a Disconnect the Pod 2 E5382A Flying Lead Probe Set’s bits 2, 6, 10, and 

14 from the SMA/Flying Lead test connectors’ pin strip connectors.

The original E5382A Flying Lead Probe Set should still be connected to Pod 1. 

The Pod 1 clock will be used for all tests.

b Connect the Pod 1 E5382A Flying Lead Probe Set’s bits 6 and 14 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

c Connect the Pod 1 E5382A Flying Lead Probe Set’s bits 2 and 10 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

2 On the 8133A pulse generator, in the PULSE setup for CHANNEL 2, press 

the COMP button to return the outputs to normal.

3 Note that the signal on the oscilloscope has moved. Change the 

oscilloscope’s horizontal position to 800 ps (or as required) to center the 

measured pulse on the oscilloscope display.
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4 Verify the DC offset and adjust it if necessary. See page 36.

5 Set the frequency of the pulse generator. The logic analyzer will be tested 

using a double-edge clock. The test frequency is half the test clock rate 

because data is acquired on both the rising edge and the falling edge of the 

clock. Set the frequency to 400 MHz plus the frequency uncertainty of the 

pulse generator, plus a test margin of 1%.

For example, if you are using an 8133A pulse generator, the frequency accuracy 

is ±1% of setting. Use a test margin of 1%. Set the frequency to 400 MHz plus 2% 

(408 MHz).

6 Verify the oscilloscope Deskew and adjust if necessary. See page 37.

7 Adjust the measured pulse width to 750 ps:

In this procedure, you will use the oscilloscope’s measurement markers to 

measure the actual pulse width in the test setup. Then you will adjust the pulse 

generator so that the measured pulse width is as specified.

a Observe the 54845A oscilloscope display. Change the Channel 2 pulse 

width of the 8133A pulse generator so that the pulse width measured at 

1 volt on the oscilloscope is equal to 750 ps minus the measurement 

uncertainty and display resolution of the oscilloscope, further reduced 

by 35 ps for test margin. 

For example, if you are using the 54845A/B oscilloscope, the measurement 

uncertainty is ±((0.007% * ∆t) + (full scale/2x memory depth) + 30 ps) ≅ 

±30 ps. Add 5 ps for display resolution. Add 35 ps test margin.

750 ps - 30 ps - 5 ps - 35 ps = 680 ps

Therefore, set the pulse width as measured on the 54845A/B oscilloscope to 

680 ps.

b In the oscilloscope horizontal setup, change the position to 450 ps. 

Change the horizontal scale to 100 ps/div. This will make it easier for 

you to set the pulse width accurately.
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c On the oscilloscope, move the Ax and Bx markers to the crossing points 

of the pulse and the horizontal center line. Read the pulse width at the 

bottom of the oscilloscope display. It is displayed as “∆=”.

8 Change the sampling option:

a Click the  Sampling Setup icon.

b In the Analyzer Setup dialog’s Sampling tab, select the “800 Mb/s” 

Sampling Option.

c Make sure the Clock Mode is “Periodic”.

d Click “OK” to close the Analyzer Setup dialog.

9 Change the logic analyzer pod assignment to use Pod 1. See page 53.

10 Re-assign bits to “My Bus 1”:

a Click the  Bus/Signal Setup icon.

b In the Analyzer Setup dialog’s Buses/Signals tab, re-assign the 

“My Bus 1” bus name to bits 2, 6, 10, and 14 of Pod 1.

(The threshold voltages for Pod 1 and the Pod 1 clock were previously set up 

to “1 V” and “differential”, respectively.)
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c Click “OK” to close the Analyzer Setup dialog.

11 Adjust sampling positions using eye finder:

a Click the  Sampling Setup icon.

b In the Analyzer Setup dialog’s Sampling tab, make sure “Rising Edge” is 

selected for Pod1 Clk1.

c Click “Thresholds and Sample Positions...”.

d In the Thresholds and Sample Positions dialog, expand the “My Bus 1” 

bus name so you can see the individual signals in the bus.

e Grab the blue bar for “My Bus 1” and move it to approximately -2.1 ns. 

All blue bars will follow.

f Click “Run” (the green button in the lower left-hand corner of the 

dialog).

Note the average sampling position chosen by eye finder:______ns.

In the following example, the average sampling position is -2.14 ns. The 

position may be different based on your test setup.
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Note that in this step, you place the blue bars in the first narrow window (not 

the wide window) that appears to the left of zero in the eye finder display.

g Bring stray channels into alignment if necessary. See page 45.

h Click “OK” to close the Thresholds and Sample Positions dialog.

i Now, select “Both Edges” for Pod1 Clk1.

j Click “Thresholds and Sample Positions...”.

k In the Thresholds and Sample Positions dialog, align the blue bars 

vertically. See page 43.

l Grab the blue bar for “My Bus 1” and move it to the recommended 

starting position you noted in the prior step.

m Click “Run” (the green button in the lower left-hand corner of the 

dialog) again.

Some eyes may close, but the eyes in the sampling position you chose on 

page 62 should remain open.

12 Perform the procedure “Determine PASS/FAIL (1 of 2 tests):” on page 46.

13 Make sure the logic analyzer is set up for testing data acquisition:
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a In the Listing window, make sure the logic analyzer is set up to trigger 

on My Bus 1 value “A”.

b Click the  Run icon.

c Make sure the search marker is set up to search for 131072 occurrences 

of A’s or 5’s. See page 46.

14 Click the  Run Repetitive icon.

15 Perform the procedure “Determine PASS/FAIL (2 of 2 tests):” on page 47.

16 Test the complement of the bits:

a On the 8133A pulse generator, in the PULSE setup for CHANNEL 2, 

select COMP.

b Note that the signal on the oscilloscope has moved. Change the 

oscilloscope’s horizontal position to -300 ps (or as required) to center 

the measured pulse on the oscilloscope display.

c Verify the DC offset and adjust it if necessary. See page 36.

d Deskew the oscilloscope. See page 37.

e Adjust the measured pulse width to 750 ps (minus the test margin). 

See page 60.

f Run eye finder.

g Perform the procedure “Determine PASS/FAIL (1 of 2 tests):” on 

page 46.

h Click the  Run Repetitive icon.

i Perform the procedure “Determine PASS/FAIL (2 of 2 tests):” on 

page 47.
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Test Pod 2 in 800 Mb/s mode

1 Change test equipment connections:

a Leave the first E5382A Flying Lead Probe Set connected to Pod 1 of the 

logic analyzer. Remove the Pod 1 flying leads 2, 6, 10, and 14 from the 

SMA/Flying Lead test connectors. Do not remove the flying leads that 

are connected to CLK and CLK flying leads.

b Connect the Pod 2 E5382A Flying Lead Probe Set’s bits 6 and 14 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

c Connect the Pod 2 E5382A Flying Lead Probe Set’s bits 2 and 10 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

2 On the 8133A pulse generator, in the PULSE setup for CHANNEL 2, press 

the COMP button to return the outputs to normal.

3 Note that the signal on the oscilloscope has moved. Change the 

oscilloscope’s horizontal position to 450 ps (or as required) to center the 

measured pulse on the oscilloscope display.

4 Verify the DC offset and adjust it if necessary. See page 36.

5 Deskew the oscilloscope if necessary. See page 37.

6 Adjust the measured pulse width from the pulse generator to 750 ps 

(minus the test margin) as described on page 60.

7 Change the logic analyzer pod assignment to use Pod 2. See page 58.

8 Re-assign bits to “My Bus 1”:

a Click the  Bus/Signal Setup icon.

b In the Analyzer Setup dialog’s Buses/Signals tab, re-assign the 

“My Bus 1” bus name to bits 2, 6, 10, and 14 of Pod 2.

(The threshold voltages for Pod 2 and the Pod 1 clock were previously set up 

to “1 V” and “differential”, respectively.)

c Click “OK” to close the Analyzer Setup dialog.

9 Adjust the sampling positions using eye finder. Be sure to expand 

“My Bus 1”. You can use the starting position you noted on page 62. Bring 

stray channels into alignment if necessary. See page 45.
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10 Determine pass or fail (1 of 2 tests). See page 46.

11 Make sure the logic analyzer is set up for testing data acquisition:

a In the Listing window, make sure the logic analyzer is set up to trigger 

on My Bus 1 value “A”.

b Click the  Run icon.

c Make sure the search marker is set up to search for 131072 occurrences 

of A’s or 5’s. See page 46.

12 Click the  Run Repetitive icon.

13 Determine pass or fail (2 of 2 tests). See page 47.

14 Test the complement of the bits on Pod 2. You can use the procedure “Test 

the complement of the bits:” on page 64 as a guideline.

Test Pod 1 in 1250 Mb/s mode

1 Change test equipment connections:

a Disconnect the Pod 2 E5382A Flying Lead Probe Set’s bits 2, 6, 10, and 

14 from the SMA/Flying Lead test connectors’ pin strip connectors.

The original E5382A Flying Lead Probe Set should still be connected to Pod 1. 

The Pod 1 clock will be used for all tests.

b Connect the Pod 1 E5382A Flying Lead Probe Set’s bits 6 and 14 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

c Connect the Pod 1 E5382A Flying Lead Probe Set’s bits 2 and 10 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

2 On the 8133A pulse generator, in the PULSE setup for CHANNEL 2, press 

the COMP button to return the outputs to normal.

3 Note that the signal on the oscilloscope has moved. Change the 

oscilloscope’s horizontal position to 450 ps (or as required) to center the 

measured pulse on the oscilloscope display.

NOTE: You can temporarily reduce the frequency on the pulse generator and increase 

the horizontal scale on the oscilloscope to verify that you are measuring the 

correct pulse. Then return the settings to normal.
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4 Verify the DC offset and adjust it if necessary. See page 36.

5 Set the frequency of the pulse generator. The logic analyzer will be tested 

using a double-edge clock. The test frequency is half the test clock rate 

because data is acquired on both the rising edge and the falling edge of the 

clock. Set the frequency to 625 MHz plus the frequency uncertainty of the 

pulse generator, plus a test margin of 1%.

For example, if you are using an 8133A pulse generator, the frequency accuracy 

is ±1% of setting. Use a test margin of 1%. Set the frequency to 625 MHz plus 2% 

(638 MHz).

6 Verify the oscilloscope Deskew and adjust if necessary. See page 37.

7 Adjust the measured pulse width from the pulse generator to 750 ps 

(minus the test margin) as described on page 60.

8 Change the sampling option:

a Click the  Sampling Setup icon.

b In the Analyzer Setup dialog’s Sampling tab, select the “1250 Mb/s Half 

Channel” Sampling Option.

c Click “OK” to close the Analyzer Setup dialog.

9 Change the logic analyzer pod assignment to use Pod 1. See page 53.

10 Re-assign bits to “My Bus 1”:

a Click the  Bus/Signal Setup icon.

b In the Analyzer Setup dialog’s Buses/Signals tab, re-assign the 

“My Bus 1” bus name to bits 2, 6, 10, and 14 of Pod 1.

(The threshold voltages for Pod 1 and the Pod 1 clock were previously set up 

to “1 V” and “differential”, respectively.)

c Click “OK” to close the Analyzer Setup dialog.

11 Adjust sampling positions using eye finder:

In the 1250 Mb/s mode, only double-edge clocking (“Both Edges”) is available. 

Therefore, we will use a different method for ensuring that we are measuring the 

correct eye.

a Set the pulse generator frequency to half of the required value. If it was 

set to 638 MHz, then temporarily set it to 319 MHz.

b Click the  Sampling Setup icon.
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c In the Analyzer Setup dialog’s Sampling tab, click “Thresholds and 

Sample Positions...”.

d In the Thresholds and Sample Positions dialog, expand the “My Bus 1” 

bus name so you can see the individual signals in the bus.

e Grab the blue bar for “My Bus 1” and move it to approximately -0.94 ns. 

All blue bars will follow.

f Click “Run” (the green button in the lower left-hand corner of the 

dialog).

Note the average sampling position chosen by eye finder:______ns.

In the following example, the average sampling position is -0.97 ns. The 

position may be different based on your test setup.

Note that in this step, you place the blue bars in the first narrow window (not 

the wide window) that appears to the left of zero in the eye finder display.

g Bring stray channels into alignment if necessary. See page 45.

h Re-set the pulse generator frequency to 625 MHz plus the test margin 

(638 MHz).

i Align the blue bars vertically. See page 43.

j Grab the blue bar for “My Bus 1” and move it to the recommended 

starting position you noted in the prior step.
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k Click “Run” (the green button in the lower left-hand corner of the 

dialog) again.

Some eyes may close, but the eyes in the sampling position you chose on 

page 68 should remain open.

l Re-align stray blue bars if necessary. See page 45.

12 Perform the procedure “Determine PASS/FAIL (1 of 2 tests):” on page 46.

13 Make sure the logic analyzer is set up for testing data acquisition:

a In the Listing window, make sure the logic analyzer is set up to trigger 

on My Bus 1 value “A”.

b Click the  Run icon.

c Make sure the search marker is set up to search for 131072 occurrences 

of A’s or 5’s. See page 46.

14 Click the  Run Repetitive icon.

15 Perform the procedure “Determine PASS/FAIL (2 of 2 tests):” on page 47.

16 Test the complement of the bits:

a On the 8133A pulse generator, in the PULSE setup for CHANNEL 2, 

select COMP.
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b Note that the signal on the oscilloscope has moved. Change the 

oscilloscope’s horizontal position to -300 ps (or as required) to center 

the measured pulse on the oscilloscope display.

c Verify the DC offset and adjust it if necessary. See page 36.

d Deskew the oscilloscope. See page 37.

e Adjust the measured pulse width from the pulse generator to 750 ps 

(minus the test margin) as described on page 60.

f Run eye finder.

g Perform the procedure “Determine PASS/FAIL (1 of 2 tests):” on 

page 46.

h Click the  Run Repetitive icon.

i Perform the procedure “Determine PASS/FAIL (2 of 2 tests):” on 

page 47.

Test Pod 2 in 1250 Mb/s mode

1 Change test equipment connections:

a Leave the first E5382A Flying Lead Probe Set connected to Pod 1 of the 

logic analyzer. Remove the Pod 1 flying leads 2, 6, 10, and 14 from the 

SMA/Flying Lead test connectors. Do not remove the flying leads that 

are connected to CLK and CLK flying leads.

b Connect the Pod 2 E5382A Flying Lead Probe Set’s bits 6 and 14 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

c Connect the Pod 2 E5382A Flying Lead Probe Set’s bits 2 and 10 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

2 On the 8133A pulse generator, in the PULSE setup for CHANNEL 2, press 

the COMP button to return the outputs to normal.

3 Note that the signal on the oscilloscope has moved. Change the 

oscilloscope’s horizontal position to 450 ps (or as required) to center the 

measured pulse on the oscilloscope display.

4 Verify the DC offset and adjust it if necessary. See page 36.

5 Deskew the oscilloscope if necessary. See page 37.
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6 Adjust the measured pulse width from the pulse generator to 750 ps 

(minus the test margin) as described on page 60.

7 Change the logic analyzer pod assignment to use Pod 2. See page 58.

8 Re-assign bits to “My Bus 1”:

a Click the  Bus/Signal Setup icon.

b In the Analyzer Setup dialog’s Buses/Signals tab, re-assign the 

“My Bus 1” bus name to bits 2, 6, 10, and 14 of Pod 2.

(The threshold voltages for Pod 2 and the Pod 1 clock were previously set up 

to “1 V” and “differential”, respectively.)

c Click “OK” to close the Analyzer Setup dialog.

9 Adjust the sampling positions using eye finder. Be sure to expand 

“My Bus 1”. You can use the starting position you noted on page 68. Re-

align any stray channels if necessary. See page 45.

10 Determine pass or fail (1 of 2 tests). See page 46.

11 Make sure the logic analyzer is set up for testing data acquisition:

a In the Listing window, make sure the logic analyzer is set up to trigger 

on My Bus 1 value “A”.

b Click the  Run icon.

c Make sure the search marker is set up to search for 131072 occurrences 

of A’s or 5’s. See page 46.

12 Click the  Run Repetitive icon.

13 Determine pass or fail (2 of 2 tests). See page 47.

14 Test the complement of the bits on Pod 2. You can use the procedure “Test 

the complement of the bits:” on page 69 as a guideline.
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Test Pod 1 in 1500 Mb/s mode

1 Change test equipment connections:

a Disconnect the Pod 2 E5382A Flying Lead Probe Set’s bits 2, 6, 10, and 

14 from the SMA/Flying Lead test connectors’ pin strip connectors.

The original E5382A Flying Lead Probe Set should still be connected to Pod 1. 

The Pod 1 clock will be used for all tests.

b Connect the Pod 1 E5382A Flying Lead Probe Set’s bits 6 and 14 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

c Connect the Pod 1 E5382A Flying Lead Probe Set’s bits 2 and 10 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

2 On the 8133A pulse generator, in the PULSE setup for CHANNEL 2, press 

the COMP button to return the outputs to normal.

3 Note that the signal on the oscilloscope has moved. Change the 

oscilloscope’s horizontal position to 450 ps (or as required) to center the 

measured pulse on the oscilloscope display.

NOTE: You can temporarily reduce the frequency on the pulse generator and increase 

the horizontal scale on the oscilloscope to verify that you are measuring the 

correct pulse. Then return the settings to normal.

4 Verify the DC offset and adjust it if necessary. See page 36.

5 Set the frequency of the pulse generator. The logic analyzer will be tested 

using a double-edge clock. The test frequency is half the test clock rate 

because data is acquired on both the rising edge and the falling edge of the 

clock. Set the frequency to 750 MHz plus the frequency uncertainty of the 

pulse generator, plus a test margin of 1%.

For example, if you are using an 8133A pulse generator, the frequency accuracy 

is ±1% of setting. Use a test margin of 1%. Set the frequency to 750 MHz plus 2% 

(765 MHz).

6 Verify the oscilloscope Deskew and adjust if necessary. See page 37.

7 Adjust the measured pulse width to 600 ps:

In this procedure, you will use the oscilloscope’s measurement markers to 

measure the actual pulse width in the test setup. Then you will adjust the pulse 

generator so that the measured pulse width is as specified.
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a Observe the 54845A oscilloscope display. Change the Channel 2 pulse 

width of the 8133A pulse generator so that the pulse width measured at 

1 volt on the oscilloscope is equal to 600 ps minus the measurement 

uncertainty and display resolution of the oscilloscope, further reduced 

by 35 ps for test margin.

For example, if you are using the 54845A/B oscilloscope, the measurement 

uncertainty is ±((0.007% * ∆t) + (full scale/2x memory depth) + 30 ps) ≅ 

±30 ps. Add 5 ps for display resolution. Add 35 ps test margin.

600 ps - 30 ps - 5 ps - 35 ps = 530 ps

Therefore, set the pulse width as measured on the 54845A/B oscilloscope to 

530 ps.

b In the oscilloscope horizontal setup, change the position to 300 ps (or 

as required) to center the pulse on the display.

c On the oscilloscope, move the Ax and Bx markers to the crossing points 

of the pulse and the horizontal center line. Read the pulse width at the 

bottom of the oscilloscope display. It is displayed as “∆=”.
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8 Change the sampling option:

a Click the  Sampling Setup icon.

b In the Analyzer Setup dialog’s Sampling tab, select the “1500 Mb/s Half 

Channel” Sampling Option.

c Click “OK” to close the Analyzer Setup dialog.

9 Change the logic analyzer pod assignment to use Pod 1. See page 53.

10 Re-assign bits to “My Bus 1”:

a Click the  Bus/Signal Setup icon.

b In the Analyzer Setup dialog’s Buses/Signals tab, re-assign the 

“My Bus 1” bus name to bits 2, 6, 10, and 14 of Pod 1.

(The threshold voltages for Pod 1 and the Pod 1 clock were previously set up 

to “1 V” and “differential”, respectively.)

c Click “OK” to close the Analyzer Setup dialog.

11 Adjust sampling positions using eye finder:

a Set the pulse generator frequency to half of the required value. If it was 

set to 765 MHz, then temporarily set it to 383 MHz.

b Click the  Sampling Setup icon.

c In the Analyzer Setup dialog’s Sampling tab, click “Thresholds and 

Sample Positions...”.

d In the Thresholds and Sample Positions dialog, expand the “My Bus 1” 

bus name so you can see the individual signals in the bus.

e Grab the blue bar for “My Bus 1” and move it to approximately 3.1 ns. 

All blue bars will follow.

f Click “Run” (the green button in the lower left-hand corner of the 

dialog).

Note the average sampling position chosen by eye finder:______ns.
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In the following example, the average sampling position is 3.10 ns. The 

position may be different based on your test setup.

Note that in this step, you place the blue bars in the last complete narrow 

window that appears on the right in the eye finder display.

g Bring stray channels into alignment if necessary. See page 45.

h Re-set the pulse generator frequency to 750 MHz plus the test margin 

(765 MHz).

i Align the blue bars vertically. See page 43.

j Grab the blue bar for “My Bus 1” and move it to the recommended 

starting position you noted in the prior step.

k Click “Run” (the green button in the lower left-hand corner of the 

dialog) again.

www.valuetronics.com



76   

Chapter 3: Testing Performance

Manual Test Procedure, 16900-Series Mainframe

Some eyes may close, but the eyes in the sampling position you chose on 

page 74 should remain open.

l Re-align stray blue bars if necessary. See page 45.

12 Perform the procedure “Determine PASS/FAIL (1 of 2 tests):” on page 46.

13 Make sure the logic analyzer is set up for testing data acquisition:

a In the Listing window, make sure the logic analyzer is set up to trigger 

on My Bus 1 value “A”.

b Click the  Run icon.

c Make sure the search marker is set up to search for 131072 occurrences 

of A’s or 5’s. See page 46.

14 Click the  Run Repetitive icon.

15 Perform the procedure “Determine PASS/FAIL (2 of 2 tests):” on page 47.

16 Test the complement of the bits:

a On the 8133A pulse generator, in the PULSE setup for CHANNEL 2, 

select COMP.

b Note that the signal on the oscilloscope has moved. Change the 

oscilloscope’s horizontal position to -350 ps (or as required) to center 

the measured pulse on the oscilloscope display.

c Verify the DC offset and adjust it if necessary. See page 36.
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d Deskew the oscilloscope. See page 37.

e Verify that the pulse width is set to 600 ps. See page 72.

f Run eye finder.

g Perform the procedure “Determine PASS/FAIL (1 of 2 tests):” on 

page 46.

h Click the  Run Repetitive icon.

i Perform the procedure “Determine PASS/FAIL (2 of 2 tests):” on 

page 47.

Test Pod 2 in 1500 Mb/s mode

1 Change test equipment connections:

a Leave the first E5382A Flying Lead Probe Set connected to Pod 1 of the 

logic analyzer. Remove the Pod 1 flying leads 2, 6, 10, and 14 from the 

SMA/Flying Lead test connectors. Do not remove the flying leads that 

are connected to CLK and CLK flying leads.

b Connect the Pod 2 E5382A Flying Lead Probe Set’s bits 6 and 14 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

c Connect the Pod 2 E5382A Flying Lead Probe Set’s bits 2 and 10 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

2 On the 8133A pulse generator, in the PULSE setup for CHANNEL 2, press 

the COMP button to return the outputs to normal.

3 Note that the signal on the oscilloscope has moved. Change the 

oscilloscope’s horizontal position to 300 ps (or as required) to center the 

measured pulse on the oscilloscope display.

4 Verify the DC offset and adjust it if necessary. See page 36.

5 Deskew the oscilloscope if necessary. See page 37.

6 Adjust the measured pulse width from the pulse generator to 600 ps 

(minus the test margin) as described on page 72.

7 Change the logic analyzer pod assignment to use Pod 2. See page 58.
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8 Re-assign bits to “My Bus 1”:

a Click the  Bus/Signal Setup icon.

b In the Analyzer Setup dialog’s Buses/Signals tab, re-assign the 

“My Bus 1” bus name to bits 2, 6, 10, and 14 of Pod 2.

(The threshold voltages for Pod 2 and the Pod 1 clock were previously set up 

to “1 V” and “differential”, respectively.)

c Click “OK” to close the Analyzer Setup dialog.

9 Adjust the sampling positions using eye finder. Be sure to expand 

“My Bus 1”. You can use the starting position you noted on page 74. Re-

align any stray channels if necessary. See page 45.

10 Determine pass or fail (1 of 2 tests). See page 46.

11 Make sure the logic analyzer is set up for testing data acquisition:

a In the Listing window, make sure the logic analyzer is set up to trigger 

on My Bus 1 value “A”.

b Click the  Run icon.

c Make sure the search marker is set up to search for 131072 occurrences 

of A’s or 5’s. See page 46.

12 Click the  Run Repetitive icon.

13 Determine pass or fail (2 of 2 tests). See page 47.

14 Test the complement of the bits on Pod 2. You can use the procedure “Test 

the complement of the bits:” on page 76 as a guideline.
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The steps that follow include pass/fail criteria.

Test Pod 1 in 200 Mb/s Mode

1 Configure the logic analyzer:

a Configure the Sampling settings:

i In the Agilent 16700-series logic analysis system’s System window, select 

the 16760A logic analyzer icon, then select “Setup and Trigger”. A Setup 

and Trigger window will appear.

ii In the logic analyzer Setup and Trigger window, select the Sampling tab (if 

it is not already selected).

iii Under the Sampling tab, select State Mode.

iv Under State Mode Controls, select the “200 Mb/s / 32 M State” mode.

v Under Clock Setup, at the bottom of the Clock J column, select the clock 

edge field and set the J clock to “Both Edges”.

clock

edge

field
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b Configure the Acquisition settings:

i In the logic analyzer Setup and Trigger window, select the Trigger tab.

ii Under the Trigger tab, select the Settings subtab.

iii Select the Acquisition Depth field, then select 128K.

iv Select the Trigger Position field, then select Start.

v Select the Count field, then select Off.

c Configure the Format settings:

i In the logic analyzer Setup and Trigger window, select the Format tab.

ii Under the Format tab, select Pod Assignment.

iii In the Pod Assignment window, use the mouse to drag the pod from the 

Unassigned Pods column to the Analyzer 1 column.

iv Select Close to close the Pod Assignment window.
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v Under the Format tab, use the scroll bar to scroll to the right so you can 

see the fields for Pod 1.

vi Select the channel assignment field for the pod being tested, then select 

Individual in the pop-up menu.

vii Using the mouse, select each asterisk to un-assign all data channels on the 

pod. Ensure all channels are un-assigned on all pods. Now assign channels 

2, 6, 10, and 14 for the pod being tested (Pod 1). An asterisk (*) means 

that a channel is assigned.

viii Select OK to close the channel assignment window.

scroll

bar

channel

assignment

field
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d Configure the clock and data thresholds:

i Select the pod threshold field for the pod that you are going to test. The 

Pod threshold window will appear. You must have the E5382A Flying Lead 

Probe attached to the pod you will be testing so that the pod threshold 

dialog will appear when you select the pod threshold field.

ii In the Pod threshold window, select User Defined and set the threshold 

value to 1 volt. The “Apply threshold settings to all pods” check box 

doesn’t matter.

iii Select Close to close the Pod threshold window.

pod

threshold

field
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iv Under the Format tab, use the scroll bar at the bottom of the window to 

scroll to the left and select “Clk Thresh...”.

v In the Clock Thresholds window, select the J clock threshold button, then 

in the J threshold window select Differential.

vi Select Close to close the J threshold window. Select Close to close the 

Clock Thresholds window.

e Configure the Trigger settings:

i In the logic analyzer Setup and Trigger window, under the Trigger tab, 

select the Trigger Functions subtab.

ii Select “Find pattern n times”.

iii Select the Replace button.

clock

threshold

button

scroll

bar
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iv Enter “A” in the “Label 1 =” field.

2 Adjust sampling positions using eye finder:

a In the Setup and Trigger window, select the Sampling tab, then select 

the “Sampling Positions...” button (which is in the Clock Setup area of 

the window). The eye finder window will appear. Ensure that the 

“Sampling Positions” tab is selected.

b From the menu bar in the eye finder window, select Results.

c Select “Remove All Eye Finder Data” if this selection is available (if it is 

not ghosted). Select “Yes” to confirm that you want to remove the data.

d Select Label1, then select Expand (if not already expanded).

e If the blue bars in the eye finder display are not vertically aligned:

i Grab the right-most blue bar in the “Label1 (4 channels)” row with the 

mouse pointer and move it all the way to the left and release the mouse 

button. This will vertically align all of the blue bars.

f Select the Sampling Positions tab in the eye finder window.

g Using the mouse pointer, grab the blue bar for “Label 1 (4 channels)” 

and move it to the recommended starting position of 0.6 ns. All of the 

blue bars will follow.
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h Click “Run Eye Finder” (the large green button).

i Ensure that an eye appears for each bit near the recommended starting 

position. Depending on your test setup, the eye position may vary. Any 

skew between channel 1 and channel 2 of your pulse generator will 

cause the eye position to shift to the left or right in the eye finder 

display. A shift of up to 0.5 ns should be considered normal. The 

important point is that your eye finder display should look similar to 

the picture below (although it may be shifted left or right), and eye 

finder must be able to place the blue bars in the narrow eye.

j Re-align any stray channels if necessary. See page 86.
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Re-Aligning a Stray Channel

If the blue bar for a particular bit does not appear in its eye near the recommended starting position, you 
need to re-align the sampling position of the stray channel. In the following example, the sampling position of 
one channel (Label1 [2]) must be re-aligned with the sampling position of the other channels. (The following 
example shows the analyzer in the 1500 Mb/s mode.)

Using the mouse, drag the sample position (blue line) of a stray channel so that it is in the same eye as the 
other channels (drag channel Label1 [2] in the above example). The Suggested Position from eye finder (green 
triangle) will also move to the new eye. Do this for all remaining stray channels.

Click “Run Eye Finder”. Eye finder will recalculate the new sample positions based on the sample position 
changes. The following example shows all sampling positions aligned and in the correct eye (with the 
analyzer in the 1500 Mb/s mode).
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3 Determine PASS/FAIL (1 of 2 tests):

a PASS/FAIL: If an eye exists near the recommended starting position for 

every bit, and eye finder places a blue bar in the eye for each bit, then 

the logic analyzer passes this portion of the test.

b If an eye does not exist near the recommended starting position for 

every bit or eye finder cannot place the blue bar in the eye, then the 

logic analyzer fails the test. Record the failure in the test record (shown 

on page 118).

4 Open and configure the Listing window:

a In the Setup and Trigger window, select Window from the menu bar, 

then select Slot n: Analyzer<n> (where n is the slot where the module 

under test is installed). At the pop-up menu, select Listing. The Listing 

window will appear.

b In the Listing window, select the Markers tab.

c Select the G1: button and the Markers Setup window will appear.

d Select the field immediately to the right of G1, and select Pattern.

e Select the field immediately to the right of G2, and select Pattern.
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f Right-click on the Interval field (which is below G1 and G2) and select 

Delete.

g Select the field immediately to the right of “Data at” and select 

Beginning.

NOTE: Leave the marker Setup window open. You will be entering numeric values in the 

"occurs" field after acquiring the first run of test data.

h Configure the Markers.

i In the logic analyzer Listing window, select the Run icon. This will load the 

logic analyzer memory with data so the markers can be configured. An 

error message will appear because the marker patterns are not yet 

specified.

ii Select OK to close the error message window.

iii In the Marker Setup window, select the G1 Define... button. The “Marker 

Pattern for <G1>” window will appear. In the pattern field, enter "a", then 

select Close.

iv In the Marker Setup window, select the G2 Define... button. The G2 

Marker Pattern window will appear. In the pattern field, enter "5", then 

select Close.

v In the Marker Setup window, select the 'occurs' value field that 

corresponds to marker G1. Enter 65535.

vi In the Marker Setup window, select the 'occurs' value field that 
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corresponds to marker G2. Enter 65535, then press Enter.

vii Select Close.

i In the Listing window, Select the Run Repetitive icon. The analyzer will 

run and the listing window will update every few seconds.

5 Determine PASS/FAIL (2 of 2 tests):

Pass/Fail Point: The Listing window is set up to search for the appropriate 

number of A's and 5's in the acquisition. If the logic analyzer does not detect the 

correct number of A’s and 5’s, an error window will appear. The window will be 

named 'Error - Listing', and it will say “Pattern NOT found for marker...”.

a Let the logic analyzer run repetitive for about 1 minute. If no error 

message is displayed, the test passes.
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If the red error window “Error- Listing <1> Pattern NOT found...” appears 

during the minute or so that it runs repetitively, then the logic analyzer fails 

the test. Record the failure in the appropriate place on the test record.

NOTE: Be sure that the black ground clip is making good contact with the ground pin on 

the test connector.

b After approximately 1 minute select the red stop button in the Listing 

window.

NOTE: As a point of curiosity, you may want to determine the absolute minimum pulse 

width and/or absolute maximum frequency at which data can be acquired. The 

“Performance Test Record” on page 118 does not include places for recording 

these values because the Performance Verification procedure only verifies that 

the logic analyzer meets specifications. Determination of additional parameters is 

not required, but may be performed at the discretion of the calibration laboratory.

On some pulse generators, the signal outputs may become slightly unstable for a 

very short period of time when the signal parameters are adjusted. Adjusting the 

pulse generator while the logic analyzer is running can cause a false failure.

If the Pattern NOT found error message appears while making an adjustment to 

the pulse generator select OK to close the window. If the message appears again 

after you have stopped adjusting the pulse generator and allowed a short settling 

time for the pulse generator, then the logic analyzer fails the test.

6 Test the complement of the bits:

a On the 8133A pulse generator, in the PULSE setup for CHANNEL 2, 

select COMP.

b Note that the signal on the oscilloscope has moved. Change the 

oscilloscope’s horizontal position to -600 ps (or as required) to center 

the measured pulse on the oscilloscope display.

c Verify the DC offset and adjust it if necessary. See page 36.

d Deskew the oscilloscope if necessary. See page 37.
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e Adjust the oscilloscope’s measurement markers to measure the pulse 

width. Set the markers so that ∆=1430 ps (this assumes you are using 

the 8133A pulse generator and the Infiniium oscilloscope). Adjust the 

pulse generator so that the pulse width is 1430 ps as measured by the 

markers. See page 38 for details.

f Adjust the sampling positions (run eye finder). See page 84.

g Determine pass or fail (1 of 2 tests). See page 87.

h Ensure that the Listing window is set up. See page 87.

i Select the Run Repetitive icon in the Listing window.

j Determine pass or fail (2 of 2 tests). See page 89.

Test Pod 2 in 200 Mb/s Mode

1 Change test equipment connections:

a Leave the first E5382A Flying Lead Probe Set connected to Pod 1 of the 

logic analyzer. Remove the Pod 1 flying leads 2, 6, 10, and 14 from the 
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SMA/Flying Lead test connectors. Do not remove the flying leads that 

are connected to CLK and CLK.

b Connect the second E5382A Flying Lead Probe Set to Pod 2 of the logic 

analyzer.

c Connect the Pod 2 E5382A Flying Lead Probe Set’s bits 6 and 14 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

d Connect the Pod 2 E5382A Flying Lead Probe Set’s bits 2 and 10 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

2 On the 8133A pulse generator, in the PULSE setup for CHANNEL 2, press 

the COMP button to return the outputs to normal.

3 Note that the signal on the oscilloscope has moved. Change the 

oscilloscope’s horizontal position to 800 ps (or as required) to center the 

measured pulse on the oscilloscope display.

4 Verify the DC offset and adjust it if necessary. See page 36.

5 Deskew the oscilloscope if necessary. See page 37.

6 Re-adjust the pulse width from the pulse generator as measured on the 

oscilloscope to 1.5 ns. See page 38.

7 Change the logic analyzer configuration:

a In the logic analyzer’s Setup and Trigger window, Format tab, unassign 

all pod 1 bits. A Warning window will appear stating that the trigger 

function has become invalid. Select OK to close the Warning window.

b Assign bits 2, 6, 10, and 14 of Pod 2.

c Set the Pod 2 threshold to 1 volt (just as you did for Pod 1 on page 82).

d In the “Setup and Trigger...” window, Format tab, use the scroll bar at 

the bottom of the window to scroll to the left. Ensure that the J clock 

threshold is set to Differential.

e Re-establish the trigger function:

i In the logic analyzer’s Setup and Trigger window, select the Trigger tab, 

and the Trigger Functions subtab.

ii Select “Find pattern n times” and select the “Replace” button.

iii Enter “A” in the “Label 1 = “ field.
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8 Adjust the sampling positions using eye finder. Be sure to expand “Label1 

(4 channels)” and use the recommended starting position noted on 

page 84. Re-align any stray channels if necessary. See page 86.

9 Determine pass or fail (1 of 2 tests). See page 87.

10 Ensure that the Listing window is set up. See page 87.

11 Select the Run Repetitive icon in the Listing window.

12 Determine pass or fail (2 of 2 tests). See page 89.

13 Test the complement of the bits. See page 90.

Test Pod 1 in 400 Mb/s mode

1 Change test equipment connections:

a Disconnect the Pod 2 E5382A Flying Lead Probe Set’s bits 2, 6, 10, and 

14 from the SMA/Flying Lead test connectors’ pin strip connectors.

The original E5382A Flying Lead Probe Set should still be connected to Pod 1. 

The J clock on Pod 1 will be used for all tests.

b Connect the Pod 1 E5382A Flying Lead Probe Set’s bits 6 and 14 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

c Connect the Pod 1 E5382A Flying Lead Probe Set’s bits 2 and 10 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

2 On the 8133A pulse generator, in the PULSE setup for CHANNEL 2, press 

the COMP button to return the outputs to normal.

3 Note that the signal on the oscilloscope has moved. Change the 

oscilloscope’s horizontal position to 800 ps (or as required) to center the 

measured pulse on the oscilloscope display.

4 Verify the DC offset and adjust it if necessary. See page 36.

5 Set the frequency of the pulse generator. The logic analyzer will be tested 

using a double-edge clock. The test frequency is half the test clock rate 

because data is acquired on both the rising edge and the falling edge of the 

clock. Set the frequency to 200 MHz plus the frequency uncertainty of the 

pulse generator, plus a test margin of 1%.
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For example, if you are using an 8133A pulse generator, the frequency accuracy 

is ±1% of setting. Use a test margin of 1%. Set the frequency to 200 MHz plus 2% 

(204 MHz).

6 Verify the oscilloscope Deskew and adjust if necessary. See page 37.

7 Adjust the measured pulse width from the pulse generator to 1.5 ns 

(minus the test margin) as described on page 38.

8 Change the logic analyzer configuration:

a In the logic analyzer “Setup and Trigger...” window, select the Sampling 

tab. In the “State Mode Controls” section, select the “400 Mb/s / 32M 

State” mode. The mode will change to 400 Mb/s and the clock setup will 

change to “Rising Edge.”

b In the logic analyzer’s Setup and Trigger window, Format tab, unassign 

all pod 2 bits.

c Assign bits 2, 6, 10, and 14 of Pod 1.

d Ensure that the Pod 1 threshold is set to 1 volt. See page 82.

e In the “Setup and Trigger...” window, Format tab, ensure that the J 

clock threshold is still set to Differential.

f Re-establish the trigger function:

i In the logic analyzer’s Setup and Trigger window, select the Trigger tab, 

and the Trigger Functions subtab.

ii Select “Find pattern n times” and select the “Replace” button.

iii Enter “A” in the “Label 1 = “ field.

9 Adjust sampling positions using eye finder:

a In the “Setup and Trigger...” window, Sampling tab, Clock Setup area, 

ensure that the clock mode is set to “Rising Edge”.
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b In the eye finder (Sampling Positions) window, expand “Label1 (4 

channels)”.

c Grab the blue bar for “Label1 (4 Channels)” and move it to 

approximately 0.9 ns. All blue bars will follow.

d Click “Run Eye Finder” and note the average sampling position chosen 

by eye finder:______ns. Note that in this step, you place the blue bars 

in the first narrow window (not the wide window) that appears to the 

right of zero in the eye finder display. Then run eye finder.

In the following example, the average sampling position is 0.9 ns. The position 

may be different based on your test setup.

e Bring stray channels into alignment if necessary. See page 86.

f In the “Setup and Trigger...” window, Clock Setup area, set the clock 

mode to “Both Edges.”

g In the eye finder window, align the blue bars vertically. See page 84.

h Grab the blue bar for “Label1 (4 Channels)” and move it to the 

recommended starting position you noted in the prior step.
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i Click “Run Eye Finder” again. Some eyes may close, but the eyes in the 

sampling position you chose on page 95 should remain open.

10 Perform the procedure “Determine PASS/FAIL (1 of 2 tests):” on page 87.

11 Select the Run Repetitive icon in the Listing window.

12 Perform the procedure “Determine PASS/FAIL (2 of 2 tests):” on page 89.

13 Test the complement of the bits:

a On the 8133A pulse generator, in the PULSE setup for CHANNEL 2, 

select COMP.

b Note that the signal on the oscilloscope has moved. Change the 

oscilloscope’s horizontal position to -600 ps (or as required) to center 

the measured pulse on the oscilloscope display.

c Verify the DC offset and adjust it if necessary. See page 36.

d Deskew the oscilloscope. See page 37.

e Verify that the pulse width is set to 1.5 ns. See page 38.

f Run eye finder.

g Perform the procedure “Determine PASS/FAIL (1 of 2 tests):” on 

page 87.

h Select the Run Repetitive icon in the Listing window.

i Perform the procedure “Determine PASS/FAIL (2 of 2 tests):” on 

page 89.
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Test Pod 2 in 400 Mb/s mode

1 Change test equipment connections:

a Leave the first E5382A Flying Lead Probe Set connected to Pod 1 of the 

logic analyzer. Remove the Pod 1 flying leads 2, 6, 10, and 14 from the 

SMA/Flying Lead test connectors. Do not remove the flying leads that 

are connected to CLK and CLK flying leads.

b Connect the Pod 2 E5382A Flying Lead Probe Set’s bits 6 and 14 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

c Connect the Pod 2 E5382A Flying Lead Probe Set’s bits 2 and 10 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

2 On the 8133A pulse generator, in the PULSE setup for CHANNEL 2, press 

the COMP button to return the outputs to normal.

3 Note that the signal on the oscilloscope has moved. Change the 

oscilloscope’s horizontal position to 800 ps (or as required) to center the 

measured pulse on the oscilloscope display.

4 Verify the DC offset and adjust it if necessary. See page 36.

5 Deskew the oscilloscope if necessary. See page 37.

6 Adjust the measured pulse width from the pulse generator to 1.5 ns 

(minus the test margin) as described on page 38.

7 Change the logic analyzer configuration:

a In the logic analyzer’s Setup and Trigger window, Format tab, unassign 

all pod 1 bits.

b Assign bits 2, 6, 10, and 14 of Pod 2.

c Verify that the Pod 2 threshold is set to 1 volt (just as you did for Pod 1 

on page 82).

d In the “Setup and Trigger...” window, Format tab, use the scroll bar at 

the bottom of the window to scroll to the left. Ensure that the J clock 

threshold is set to Differential.

e Re-establish the trigger function:

i In the logic analyzer’s Setup and Trigger window, select the Trigger tab, 

and the Trigger Functions subtab.
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ii Select “Find pattern n times” and select the “Replace” button.

iii Enter “A” in the “Label 1 = “ field.

8 Adjust the sampling positions using eye finder. Be sure to expand “Label1 

(4 channels)”. Use the starting position you noted on page 95. Re-align any 

stray channels if necessary. See page 86.

9 Determine pass or fail (1 of 2 tests). See page 87.

10 Ensure that the Listing window is set up. See page 87.

11 Select the Run Repetitive icon in the Listing window.

12 Determine pass or fail (2 of 2 tests). See page 89.

13 Test the complement of the bits on Pod 2. You can use the procedure “Test 

the complement of the bits:” on page 96 as a guideline.

Test Pod 1 in 800 Mb/s mode

1 Change test equipment connections:

a Disconnect the Pod 2 E5382A Flying Lead Probe Set’s bits 2, 6, 10, and 

14 from the SMA/Flying Lead test connectors’ pin strip connectors.

The original E5382A Flying Lead Probe Set should still be connected to Pod 1. 

The J clock on Pod 1 will be used for all tests.

b Connect the Pod 1 E5382A Flying Lead Probe Set’s bits 6 and 14 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

c Connect the Pod 1 E5382A Flying Lead Probe Set’s bits 2 and 10 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

2 On the 8133A pulse generator, in the PULSE setup for CHANNEL 2, press 

the COMP button to return the outputs to normal.

3 Note that the signal on the oscilloscope has moved. Change the 

oscilloscope’s horizontal position to 800 ps (or as required) to center the 

measured pulse on the oscilloscope display.

4 Verify the DC offset and adjust it if necessary. See page 36.

5 Set the frequency of the pulse generator. The logic analyzer will be tested 

using a double-edge clock. The test frequency is half the test clock rate 
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because data is acquired on both the rising edge and the falling edge of the 

clock. Set the frequency to 400 MHz plus the frequency uncertainty of the 

pulse generator, plus a test margin of 1%.

For example, if you are using an 8133A pulse generator, the frequency accuracy 

is ±1% of setting. Use a test margin of 1%. Set the frequency to 400 MHz plus 2% 

(408 MHz).

6 Verify the oscilloscope Deskew and adjust if necessary. See page 37.

7 Adjust the measured pulse width to 750 ps:

In this procedure, you will use the oscilloscope’s measurement markers to 

measure the actual pulse width in the test setup. Then you will adjust the pulse 

generator so that the measured pulse width is as specified.

a Observe the 54845A oscilloscope display. Change the Channel 2 pulse 

width of the 8133A pulse generator so that the pulse width measured at 

1 volt on the oscilloscope is equal to 750 ps minus the measurement 

uncertainty and display resolution of the oscilloscope, further reduced 

by 35 ps for test margin.

For example, if you are using the 54845A/B oscilloscope, the measurement 

uncertainty is ±((0.007% * ∆t) + (full scale/2x memory depth) + 30 ps) ≅ 

±30 ps. Add 5 ps for display resolution. Add 35 ps test margin.

750 ps - 30 ps - 5 ps - 35 ps = 680 ps

Therefore, set the pulse width as measured on the 54845A/B oscilloscope to 

680 ps.

b In the oscilloscope horizontal setup, change the position to 450 ps. 

Change the horizontal scale to 100 ps/div. This will make it easier for 

you to set the pulse width accurately.
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c On the oscilloscope, move the Ax and Bx markers to the crossing points 

of the pulse and the horizontal center line. Read the pulse width at the 

bottom of the oscilloscope display. It is displayed as “∆=”.

8 Change the logic analyzer configuration:

a In the logic analyzer “Setup and Trigger...” window, select the Sampling 

tab. In the “State Mode Controls” section, select the “800 Mb/s / 64M 

State” mode.

b In the “Setup and Trigger...” window, Sampling tab, Clock Setup area, 

set the clock mode to “Rising Edge”.
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c In the logic analyzer’s Setup and Trigger window, Format tab, unassign 

all pod 2 bits.

d Assign bits 2, 6, 10, and 14 of Pod 1.

e Ensure that the Pod 1 threshold is set to 1 volt. See page 82.

f In the “Setup and Trigger...” window, Format tab, ensure that the J 

clock threshold is still set to Differential.

g Re-establish the trigger function:

i In the logic analyzer’s Setup and Trigger window, select the Trigger tab, 

and the Trigger Functions subtab.

ii Select “Find pattern” and select the “Replace” button.

iii Enter “A” in the “Label 1 = “ field.

9 Adjust sampling positions using eye finder:

a In the eye finder (Sampling Positions) window, expand “Label1 (4 

channels)”.

b Grab the blue bar for “Label1 (4 Channels)” and move it to 

approximately -2.1 ns. All blue bars will follow.
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c Click “Run Eye Finder” and note the average sampling position chosen 

by eye finder:______ns. Note that in this step, you place the blue bars 

in the first narrow window (not the wide window) that appears to the 

left of zero in the eye finder display. Then run eye finder.

In the following example, the average sampling position is -2.09 ns. The 

position may be different based on your test setup.

d Bring stray channels into alignment if necessary. See page 86.

e In the “Setup and Trigger...” window, Clock Setup area, set the clock 

mode to “Both Edges.”

f In the eye finder window, align the blue bars vertically. See page 84.

g Grab the blue bar for “Label1 (4 Channels)” and move it to the 

recommended starting position you noted in the prior step.
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h Click “Run Eye Finder” again. Some eyes may close, but the eyes in the 

sampling position you chose on page 102 should remain open.

10 Perform the procedure “Determine PASS/FAIL (1 of 2 tests):” on page 87.

11 Select the Run Repetitive icon in the Listing window.

12 Perform the procedure “Determine PASS/FAIL (2 of 2 tests):” on page 89.

13 Test the complement of the bits:

a On the 8133A pulse generator, in the PULSE setup for CHANNEL 2, 

select COMP.

b Note that the signal on the oscilloscope has moved. Change the 

oscilloscope’s horizontal position to -300 ps (or as required) to center 

the measured pulse on the oscilloscope display.

c Verify the DC offset and adjust it if necessary. See page 36.

d Deskew the oscilloscope. See page 37.

e Adjust the measured pulse width to 750 ps (minus the test margin). 

See page 99.

f Run eye finder.

g Perform the procedure “Determine PASS/FAIL (1 of 2 tests):” on 

page 87.

h Select the Run Repetitive icon in the Listing window.
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i Perform the procedure “Determine PASS/FAIL (2 of 2 tests):” on 

page 89.

Test Pod 2 in 800 Mb/s mode

1 Change test equipment connections:

a Leave the first E5382A Flying Lead Probe Set connected to Pod 1 of the 

logic analyzer. Remove the Pod 1 flying leads 2, 6, 10, and 14 from the 

SMA/Flying Lead test connectors. Do not remove the flying leads that 

are connected to CLK and CLK flying leads.

b Connect the Pod 2 E5382A Flying Lead Probe Set’s bits 6 and 14 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

c Connect the Pod 2 E5382A Flying Lead Probe Set’s bits 2 and 10 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

2 On the 8133A pulse generator, in the PULSE setup for CHANNEL 2, press 

the COMP button to return the outputs to normal.

3 Note that the signal on the oscilloscope has moved. Change the 

oscilloscope’s horizontal position to 450 ps (or as required) to center the 

measured pulse on the oscilloscope display.

4 Verify the DC offset and adjust it if necessary. See page 36.

5 Deskew the oscilloscope if necessary. See page 37.

6 Adjust the measured pulse width from the pulse generator to 750 ps 

(minus the test margin) as described on page 99.

7 Change the logic analyzer configuration:

a In the logic analyzer’s Setup and Trigger window, Format tab, unassign 

all pod 1 bits.

b Assign bits 2, 6, 10, and 14 of Pod 2.

c Verify that the Pod 2 threshold is set to 1 volt (just as you did for Pod 1 

on page 82).

d In the “Setup and Trigger...” window, Format tab, use the scroll bar at 

the bottom of the window to scroll to the left. Verify that the J clock 

threshold is set to Differential.
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e Re-establish the trigger function:

i In the logic analyzer’s Setup and Trigger window, select the Trigger tab, 

and the Trigger Functions subtab.

ii Select “Find pattern n times” and select the “Replace” button.

iii Enter “A” in the “Label 1 = “ field.

8 Adjust the sampling positions using eye finder. Be sure to expand “Label1 

(4 channels)”. You can use the starting position you noted on page 102. 

Bring stray channels into alignment if necessary. See page 86.

9 Determine pass or fail (1 of 2 tests). See page 87.

10 Ensure that the Listing window is set up. See page 87.

11 Select the Run Repetitive icon in the Listing window.

12 Determine pass or fail (2 of 2 tests). See page 89.

13 Test the complement of the bits on Pod 2. You can use the procedure “Test 

the complement of the bits:” on page 103 as a guideline.

Test Pod 1 in 1250 Mb/s mode

1 Change test equipment connections:

a Disconnect the Pod 2 E5382A Flying Lead Probe Set’s bits 2, 6, 10, and 

14 from the SMA/Flying Lead test connectors’ pin strip connectors.

The original E5382A Flying Lead Probe Set should still be connected to Pod 1. 

The J clock on Pod 1 will be used for all tests.

b Connect the Pod 1 E5382A Flying Lead Probe Set’s bits 6 and 14 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

c Connect the Pod 1 E5382A Flying Lead Probe Set’s bits 2 and 10 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

2 On the 8133A pulse generator, in the PULSE setup for CHANNEL 2, press 

the COMP button to return the outputs to normal.

3 Note that the signal on the oscilloscope has moved. Change the 

oscilloscope’s horizontal position to 450 ps (or as required) to center the 

measured pulse on the oscilloscope display.
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NOTE: You can temporarily reduce the frequency on the pulse generator and increase 

the horizontal scale on the oscilloscope to verify that you are measuring the 

correct pulse. Then return the settings to normal.

4 Verify the DC offset and adjust it if necessary. See page 36.

5 Set the frequency of the pulse generator. The logic analyzer will be tested 

using a double-edge clock. The test frequency is half the test clock rate 

because data is acquired on both the rising edge and the falling edge of the 

clock. Set the frequency to 625 MHz plus the frequency uncertainty of the 

pulse generator, plus a test margin of 1%.

For example, if you are using an 8133A pulse generator, the frequency accuracy 

is ±1% of setting. Use a test margin of 1%. Set the frequency to 625 MHz plus 2% 

(638 MHz).

6 Verify the oscilloscope Deskew and adjust if necessary. See page 37.

7 Adjust the measured pulse width from the pulse generator to 750 ps 

(minus the test margin) as described on page 99.

8 Change the logic analyzer configuration:

a In the logic analyzer “Setup and Trigger...” window, select the Sampling 

tab. In the “State Mode Controls” section, select the “1250 Mb/s / 128M 

Half Chan” mode. The clock mode will change to “Both Edges”.

b In the logic analyzer’s Setup and Trigger window, Format tab, unassign 

all pod 2 bits. The channel assignment dialog looks different in half-

channel mode because only half of the channels can be assigned now.

c Assign bits 2, 6, 10, and 14 of Pod 1.

d Verify that the Pod 1 threshold is set to 1 volt. See page 82.

e In the “Setup and Trigger...” window, Format tab, verify that the J clock 

threshold is still set to Differential.

f Re-establish the trigger function:

i In the logic analyzer’s Setup and Trigger window, select the Trigger tab, 

and the Trigger Functions subtab.

ii Select “Find pattern n times” and select the “Replace” button.

iii Enter “A” in the “Label 1 = “ field.
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9 Adjust sampling positions using eye finder:

In the 1250 Mb/s mode, only double-edge clocking (“Both Edges”) is available. 

Therefore, we will use a different method for ensuring that we are measuring the 

correct eye.

a Set the pulse generator frequency to half of the required value. If it was 

set to 638 MHz, then temporarily set it to 319 MHz.

b In the eye finder (Sampling Positions) window, expand “Label1 (4 

channels)”.

c Grab the blue bar for “Label1 (4 Channels)” and move it to 

approximately -0.94 ns. All blue bars will follow.

d Click “Run Eye Finder” and note the average sampling position chosen 

by eye finder:______ns. Note that in this step, you place the blue bars 

in the first narrow window (not the wide window) that appears to the 

left of zero in the eye finder display. Then run eye finder.

In the following example, the average sampling position is -0.94 ns. The 

position may be different based on your test setup.

e Bring stray channels into alignment if necessary. See page 86.

f Re-set the pulse generator frequency to 625 MHz plus the test margin 

(638 MHz).

g In the eye finder window, align the blue bars vertically. See page 84.

h Grab the blue bar for “Label1 (4 Channels)” and move it to the 

recommended starting position you noted in the prior step.
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i Click “Run Eye Finder” again. Some eyes may close, but the eyes in the 

sampling position you chose on page 107 should remain open. Re-align 

stray blue bars if necessary. See page 86.

10 Perform the procedure “Determine PASS/FAIL (1 of 2 tests):” on page 87.

11 Select the Run Repetitive icon in the Listing window.

12 Perform the procedure “Determine PASS/FAIL (2 of 2 tests):” on page 89.

13 Test the complement of the bits:

a On the 8133A pulse generator, in the PULSE setup for CHANNEL 2, 

select COMP.

b Note that the signal on the oscilloscope has moved. Change the 

oscilloscope’s horizontal position to -300 ps (or as required) to center 

the measured pulse on the oscilloscope display.

c Verify the DC offset and adjust it if necessary. See page 36.

d Deskew the oscilloscope. See page 37.

e Adjust the measured pulse width from the pulse generator to 750 ps 

(minus the test margin) as described on page 99.

f Run eye finder.

g Perform the procedure “Determine PASS/FAIL (1 of 2 tests):” on 

page 87.

h Select the Run Repetitive icon in the Listing window.
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i Perform the procedure “Determine PASS/FAIL (2 of 2 tests):” on 

page 89.

Test Pod 2 in 1250 Mb/s mode

1 Change test equipment connections:

a Leave the first E5382A Flying Lead Probe Set connected to Pod 1 of the 

logic analyzer. Remove the Pod 1 flying leads 2, 6, 10, and 14 from the 

SMA/Flying Lead test connectors. Do not remove the flying leads that 

are connected to CLK and CLK flying leads.

b Connect the Pod 2 E5382A Flying Lead Probe Set’s bits 6 and 14 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

c Connect the Pod 2 E5382A Flying Lead Probe Set’s bits 2 and 10 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

2 On the 8133A pulse generator, in the PULSE setup for CHANNEL 2, press 

the COMP button to return the outputs to normal.

3 Note that the signal on the oscilloscope has moved. Change the 

oscilloscope’s horizontal position to 450 ps (or as required) to center the 

measured pulse on the oscilloscope display.

4 Verify the DC offset and adjust it if necessary. See page 36.

5 Deskew the oscilloscope if necessary. See page 37.

6 Adjust the measured pulse width from the pulse generator to 750 ps 

(minus the test margin) as described on page 99.

7 Change the logic analyzer configuration:

a In the logic analyzer’s Setup and Trigger window, Format tab, unassign 

all pod 1 bits.

b Assign bits 2, 6, 10, and 14 of Pod 2.

c Verify that the Pod 2 threshold is set to 1 volt (just as you did for Pod 1 

on page 82).

d In the “Setup and Trigger...” window, Format tab, use the scroll bar at 

the bottom of the window to scroll to the left. Verify that the J clock 

threshold is set to Differential.
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e Re-establish the trigger function:

i In the logic analyzer’s Setup and Trigger window, select the Trigger tab, 

and the Trigger Functions subtab.

ii Select “Find pattern n times” and select the “Replace” button.

iii Enter “A” in the “Label 1 = “ field.

8 Adjust the sampling positions using eye finder. Be sure to expand “Label1 

(4 channels)”. You can use the starting position you noted on page 107. 

Re-align any stray channels if necessary. See page 86.

9 Determine pass or fail (1 of 2 tests). See page 87.

10 Ensure that the Listing window is set up. See page 87.

11 Select the Run Repetitive icon in the Listing window.

12 Determine pass or fail (2 of 2 tests). See page 89.

13 Test the complement of the bits on Pod 2. You can use the procedure “Test 

the complement of the bits:” on page 108 as a guideline.

Test Pod 1 in 1500 Mb/s mode

1 Change test equipment connections:

a Disconnect the Pod 2 E5382A Flying Lead Probe Set’s bits 2, 6, 10, and 

14 from the SMA/Flying Lead test connectors’ pin strip connectors.

The original E5382A Flying Lead Probe Set should still be connected to Pod 1. 

The J clock on Pod 1 will be used for all tests.

b Connect the Pod 1 E5382A Flying Lead Probe Set’s bits 6 and 14 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

c Connect the Pod 1 E5382A Flying Lead Probe Set’s bits 2 and 10 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

2 On the 8133A pulse generator, in the PULSE setup for CHANNEL 2, press 

the COMP button to return the outputs to normal.

3 Note that the signal on the oscilloscope has moved. Change the 

oscilloscope’s horizontal position to 450 ps (or as required) to center the 

measured pulse on the oscilloscope display.
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NOTE: You can temporarily reduce the frequency on the pulse generator and increase 

the horizontal scale on the oscilloscope to verify that you are measuring the 

correct pulse. Then return the settings to normal.

4 Verify the DC offset and adjust it if necessary. See page 36.

5 Set the frequency of the pulse generator. The logic analyzer will be tested 

using a double-edge clock. The test frequency is half the test clock rate 

because data is acquired on both the rising edge and the falling edge of the 

clock. Set the frequency to 750 MHz plus the frequency uncertainty of the 

pulse generator, plus a test margin of 1%.

For example, if you are using an 8133A pulse generator, the frequency accuracy 

is ±1% of setting. Use a test margin of 1%. Set the frequency to 750 MHz plus 2% 

(765 MHz).

6 Verify the oscilloscope Deskew and adjust if necessary. See page 37.

7 Adjust the measured pulse width to 600 ps:

In this procedure, you will use the oscilloscope’s measurement markers to 

measure the actual pulse width in the test setup. Then you will adjust the pulse 

generator so that the measured pulse width is as specified.

a Observe the 54845A oscilloscope display. Change the Channel 2 pulse 

width of the 8133A pulse generator so that the pulse width measured at 

1 volt on the oscilloscope is equal to 600 ps minus the measurement 

uncertainty and display resolution of the oscilloscope, further reduced 

by 35 ps for test margin.

For example, if you are using the 54845A/B oscilloscope, the measurement 

uncertainty is ±((0.007% * ∆t) + (full scale/2x memory depth) + 30 ps) ≅ 

±30 ps. Add 5 ps for display resolution. Add 35 ps test margin.

600 ps - 30 ps - 5 ps - 35 ps = 530 ps

Therefore, set the pulse width as measured on the 54845A/B oscilloscope to 

530 ps.

b In the oscilloscope horizontal setup, change the position to 300 ps (or 

as required) to center the pulse on the display.
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c On the oscilloscope, move the Ax and Bx markers to the crossing points 

of the pulse and the horizontal center line. Read the pulse width at the 

bottom of the oscilloscope display. It is displayed as “∆=”.

8 Change the logic analyzer configuration:

a In the logic analyzer “Setup and Trigger...” window, select the Sampling 

tab. In the “State Mode Controls” section, select the “1500 Mb/s / 128M 

Half Chan” mode.

b In the logic analyzer’s Setup and Trigger window, Format tab, unassign 

all pod 2 bits.

c Assign bits 2, 6, 10, and 14 of Pod 1.

d Ensure that the Pod 1 threshold is set to 1 volt. See page 82.

e In the “Setup and Trigger...” window, Format tab, ensure that the J 

clock threshold is still set to Differential.

f Re-establish the trigger function:

i In the logic analyzer’s Setup and Trigger window, select the Trigger tab, 

and the Trigger Functions subtab.

ii Select “Find pattern n times” and select the “Replace” button.
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iii Enter “A” in the “Label 1 = “ field.

9 Adjust sampling positions using eye finder:

a Set the pulse generator frequency to half of the required value. If it was 

set to 765 MHz, then temporarily set it to 383 MHz.

b In the eye finder (Sampling Positions) window, expand “Label1 (4 

channels)”.

c Grab the blue bar for “Label1 (4 Channels)” and move it to 

approximately 3.1 ns. All blue bars will follow.

d Click “Run Eye Finder” and note the average sampling position chosen 

by eye finder:______ns. Note that in this step, you place the blue bars 

in the last complete narrow window that appears on the right in the eye 

finder display. Then run eye finder.

In the following example, the average sampling position is 3.10 ns. The 

position may be different based on your test setup.

e Bring stray channels into alignment if necessary. See page 86.

f Re-set the pulse generator frequency to 750 MHz plus the test margin 

(765 MHz).

g In the eye finder window, align the blue bars vertically. See page 84.

h Grab the blue bar for “Label1 (4 Channels)” and move it to the 

recommended starting position you noted in the prior step.
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i Click “Run Eye Finder” again. Some eyes may close, but the eyes in the 

sampling position you chose on page 113 should remain open. Re-align 

stray blue bars if necessary. See page 86.

10 Perform the procedure “Determine PASS/FAIL (1 of 2 tests):” on page 87.

11 Select the Run Repetitive icon in the Listing window.

12 Perform the procedure “Determine PASS/FAIL (2 of 2 tests):” on page 89.

13 Test the complement of the bits:

a On the 8133A pulse generator, in the PULSE setup for CHANNEL 2, 

select COMP.

b Note that the signal on the oscilloscope has moved. Change the 

oscilloscope’s horizontal position to -350 ps (or as required) to center 

the measured pulse on the oscilloscope display.

c Verify the DC offset and adjust it if necessary. See page 36.

d Deskew the oscilloscope. See page 37.

e Verify that the pulse width is set to 600 ps. See page 111.

f Run eye finder.

g Perform the procedure “Determine PASS/FAIL (1 of 2 tests):” on 

page 87.

h Select the Run Repetitive icon in the Listing window.
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i Perform the procedure “Determine PASS/FAIL (2 of 2 tests):” on 

page 89.

Test Pod 2 in 1500 Mb/s mode

1 Change test equipment connections:

a Leave the first E5382A Flying Lead Probe Set connected to Pod 1 of the 

logic analyzer. Remove the Pod 1 flying leads 2, 6, 10, and 14 from the 

SMA/Flying Lead test connectors. Do not remove the flying leads that 

are connected to CLK and CLK flying leads.

b Connect the Pod 2 E5382A Flying Lead Probe Set’s bits 6 and 14 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

c Connect the Pod 2 E5382A Flying Lead Probe Set’s bits 2 and 10 to the 

SMA/Flying Lead test connector’s pin strip connector at the 8133A 

pulse generator’s Channel 2 OUTPUT.

2 On the 8133A pulse generator, in the PULSE setup for CHANNEL 2, press 

the COMP button to return the outputs to normal.

3 Note that the signal on the oscilloscope has moved. Change the 

oscilloscope’s horizontal position to 300 ps (or as required) to center the 

measured pulse on the oscilloscope display.

4 Verify the DC offset and adjust it if necessary. See page 36.

5 Deskew the oscilloscope if necessary. See page 37.

6 Adjust the measured pulse width from the pulse generator to 600 ps 

(minus the test margin) as described on page 111.

7 Change the logic analyzer configuration:

a In the logic analyzer’s Setup and Trigger window, Format tab, unassign 

all pod 1 bits.

b Assign bits 2, 6, 10, and 14 of Pod 2.

c Verify that the Pod 2 threshold is set to 1 volt (just as you did for Pod 1 

on page 82).

d In the “Setup and Trigger...” window, Format tab, use the scroll bar at 

the bottom of the window to scroll to the left. Ensure that the J clock 

threshold is set to Differential.
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e Re-establish the trigger function:

i In the logic analyzer’s Setup and Trigger window, select the Trigger tab, 

and the Trigger Functions subtab.

ii Select “Find pattern n times” and select the “Replace” button.

iii Enter “A” in the “Label 1 = “ field.

8 Adjust the sampling positions using eye finder. Be sure to expand “Label1 

(4 channels)”. You can use the starting position you noted on page 113. 

Re-align any stray channels if necessary. See page 86.

9 Determine pass or fail (1 of 2 tests). See page 87.

10 Ensure that the Listing window is set up. See page 87.

11 Select the Run Repetitive icon in the Listing window.

12 Determine pass or fail (2 of 2 tests). See page 89.

13 Test the complement of the bits on Pod 2. You can use the procedure “Test 

the complement of the bits:” on page 114 as a guideline.
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Complete Multi-Card Module Testing

This section applies when cards were received as a multi-card module, and you 

have reconfigured them as single card modules for manual testing.

All single card modules must be reconfigured into their original multi-card 

module configuration upon completion of the “Manual Test Procedure, 16900-

Series Mainframe” or “Manual Test Procedure, 16700-Series Mainframe”.

1 Turn off the mainframe and follow the procedures in “Preparing for Use,” 

beginning on page 15 to return the cards to their original configuration.

2 Then run the self-tests as described in “Run the Software (Self) Tests” on 

page 27.

3 Finally, complete the “Performance Test Record” on page 118.

The Performance Test Record is designed to be used with the equipment 

specified on page 22. If you are not using the recommended test equipment, you 

will need to create your own version of the Performance Test Record with 

parameters that are specific to your test equipment.
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16760A Logic Analyzer

Logic Analyzer Serial No. Work Order No.

Date: Recommended Test Interval - 2 Year/4000 hours

Recommended next testing:

Test Equipment Used

Pulse Generator Model No. Oscilloscope Model No.

Pulse Generator Serial No. Oscilloscope Serial No.

Pulse Generator Calibration Due Date: Oscilloscope Calibration Due Date:

Measurement Uncertainty

Clock Rate Pulse Width (Eye Width)

Pulse Generator Frequency Accuracy:

8133A: 1% of setting

Test Margin: 1%

Oscilloscope Horizontal Accuracy:

54845B: ±[((0.007%) (∆t)+(full scale/(2x memory 

depth))+30 ps] ≅ 30 ps

54845A/B Oscilloscope Display Resolution: ±5 ps

Test Margin: 35 ps. Sum: 70 ps

Setting: 200 MHz+2%=204 MHz (102 MHz double edge)

400 MHz+2%=408 MHz (204 MHz double edge)

800 MHz+2%=816 MHz (408 MHz double edge)

1250 MHz+2%=1275 MHz (638 MHz double edge)

1500 MHz+2%=1530 MHz (765 MHz double edge)

Pulse Width setting: 1.5 ns - 70 ps = 1430 ps

Pulse Width setting: 1.5 ns - 70 ps = 1430 ps

Pulse Width setting: 750 ps - 70 ps = 680 ps

Pulse Width setting: 750 ps - 70 ps = 680 ps

Pulse Width setting: 600 ps - 70 ps = 530 ps

Tests

Test Settings

Pass/Fail Results

1 of 2: 2 of 2:

Initial Self-Tests n/a

200 Mb/s mode Minimum clock interval, min. eye width

400 Mb/s mode Minimum clock interval, min. eye width

800 Mb/s mode Minimum clock interval, min. eye width

1250 Mb/s mode Minimum clock interval, min. eye width

1500 Mb/s mode Minimum clock interval, min. eye width

Multi-card module self test n/a
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Calibrating

This chapter gives you instructions for calibrating the logic analyzer. 
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Calibration Strategy

The 16760A logic analyzer does not require an operational accuracy calibration. 

To test the module against the module specifications, refer to Chapter 3, “Testing 

Performance,” beginning on page 19.
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Troubleshooting

This chapter helps you troubleshoot the module to find defective assemblies.
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The troubleshooting consists of flowcharts, self-test instructions, a cable test, and 

a test for the auxiliary power supplied by the probe cable.

If you suspect a problem, start at the top of the first flowchart. During the 

troubleshooting instructions, the flowcharts will direct you to perform the self-

tests or the cable test.

The service strategy for this instrument is the replacement of defective 

assemblies. This module can be returned to Agilent Technologies for all service 

work, including troubleshooting. Contact your nearest Agilent Technologies Sales 

Office for more details.

CAUTION: Electrostatic discharge can damage electronic components. Use grounded wrist-

straps and mats when you perform any service to this instrument or to the cards 

in it.
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To use the flowcharts

Flowcharts are the primary tool used to isolate defective assemblies. The 

flowcharts refer to other tests to help isolate the trouble. The circled numbers on 

the charts indicate connections with the other flowcharts. Start your 

troubleshooting at the top of the first flowchart.

Mainframe Operating System

Before troubleshooting a 16760A logic analyzer module, ensure that the required 

logic analysis system software version is installed on the mainframe. The required 

software versions are listed in “Mainframe and Operating System” on page 10.
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Troubleshooting Flowchart 1
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To use the flowcharts

Troubleshooting Flowchart 2
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To run the self-tests

On a 16900-Series Mainframe

1 See Run the Software (Self) Tests “On a 16900-Series Mainframe” on 

page 27.

On a 16700-Series Mainframe

Self-tests identify the correct operation of major, functional subsystems of the 

module. You can run all self-tests without accessing the module. If a self-test fails, 

the troubleshooting flowcharts instruct you to change a part of the module.

To run the self-tests:

1 In the System window, select the System Administration icon.

2 In the System Administration window, select the Admin tab, then select 

Self-Test. At the Test Query window, select Yes.

The tests can be run individually, or all the tests can be run by selecting Test All 

at the bottom of the Self Test window. Note that if Test All is selected, system 

tests requiring user action will not be run. See the “Agilent Technologies 16700B/

16702B Logic Analysis System and 16701B Expansion Frame Service Guide” for 

more information about the mainframe self-tests. Module self-tests are described 

on page 126.

3 In the Self Test window under the System tab, select System CPU Board.

4 Run the floppy drive test.

a In the Self Test: System CPU Board window, select Floppy Drive Test.

b Insert a DOS-formatted disk with 300KB of available space in the 

mainframe floppy drive.

c In the Test Query window, select OK.

The Test Query window instructs you to insert the disk into the disk drive. 

The other System CPU Board tests require similar user action to successfully 

run the test.

5 In the Self Test: System CPU Board window, select Close to close the 

window.
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6 In the Self Test window, select PCI Board. Select Test All to run all PCI 

board tests.

In the Self Test window, select the Master Frame tab. Select the 16760A 

module to be tested, then select Test All to run all the module tests. The 

module test status should indicate PASSED (see screen on next 

page).
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Self-Test Descriptions

The self-tests for the logic analyzer identify the correct operation of major 

functional areas in the module.

CPLD Register Test. The CPLD Register Test verifies that the mainframe 

backplane can communicate with the 16760A module CPLD. The CPLD is used to 

configure the backplane and the memory devices. The test is done using both a 

walking “1” and walking “0” pattern. After the pattern has been stepped, internal 

device registers are read.

Passing the CPLD Registers Test implies that the module backplane device can 

be properly configured for module setup and data download.

Load FPGA Test. The Load FPGA Test verifies that the backplane interface 

device and the data memory control device can be configured. Configuration data 

is read from a file. During the configuration process, status signals are checked to 

verify the 16760A module hardware is operating properly during the 

configuration upload.

Passing the Load FPGA Test implies that the module can be properly configured 

for normal operation.

FPGA Register Test. The FPGA Register Test verifies that the read/write 

registers of the backplane interface device and the memory control device can be 

written to then read. Both a walking “1” and “0” pattern is written to the device 

registers. The registers are then read and compared with known values.

Passing the FPGA Registers Test implies that the module hardware configuration 

can be properly managed as part of normal module operation.

Memory Data Bus Test. The Memory Data Bus Test verifies the read/write 

access of the acquisition module from the system backplane. In addition, some of 

the operations of the acquisition memory and control are also tested. A walking 

“1” and “0” is written to the first memory location. The contents of the first 

memory location is then downloaded and compared with known values.

Passing the Memory Data Bus Test implies that data stored in the acquisition 

memory can be uploaded from the 16760A module to the system mainframe.

Memory Address Bus Test. The Memory Address Bus Test verifies the 

operation of the acquisition memory address bus. After initializing the acquisition 

memory, the address bus is exercised with a walking “1” and “0” pattern. At each 

resulting memory address, test data is stored. The test data is then downloaded 

and compared with known values.

Passing the Memory Address Bus Test implies that each signal line of the 

acquisition memory address bus is operational, and therefore all locations in the 
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acquisition memory can be accessed.

HW Assisted Memory Cell Test. After verifying the acquisition memory 

address bus signal lines using the Memory Address Bus Test, the HW Assisted 

Memory Cell Test does a read/write test on every location in the acquisition 

memory. Each location in acquisition memory is filled with a test data pattern. 

After loading acquisition memory, the test data at each memory location is 

downloaded then compared with known values.

Passing the HW Assisted Memory Cell Test implies that each location in 

acquisition memory can be accessed, written, read, and can properly store data.

Memory Unload Modes Test. The Memory Unload Modes Test verifies the CPU 

interface can properly manage the acquisition memory unload in both full-

channel, half-channel, and interleaved modes. Test data is written to acquisition 

memory. Different unload modes are selected, then the data is read and 

compared with known values.

Passing the Memory Unload Modes Test implies that the data can be reliably read 

from acquisition memory in full-channel, half-channel, or interleaved mode. This 

test along with the Memory Data Bus Test and Memory Address Bus Test provide 

complete testing of acquisition memory downloading through the CPU interface.

Memory DMA Unload Test. The Memory DMA Unload Test performs the same 

functions as the Memory Unload Test, except DMA backplane transfers are used 

to read the data from acquisition memory.

Memory Sleep Mode Test. The Memory Sleep Mode Test verifies the self 

refresh mode of acquisition memory devices. Memory self refresh mode is 

enabled when the memory control device is reprogrammed during normal 

operation.

Passing the Memory Sleep Mode Test verifies the acquisition memory will retain 

data during changes in 16760A operating modes during normal operation.

HW Accelerated Search Test. The HW Accelerated Search Test verifies the 

fundamental search capabilities of the module. Acquisition RAM is loaded with 

test data, and the search registers in the gate arrays are programmed with test 

patterns. Basic search functions including return and count pattern, are done and 

monitored for success.

Passing the HW Accelerated Search Test implies that the module’s fundamental 

Hardware accelerated pattern search capabilities are operating and that pattern 

searches and pattern occurrence counts can be performed.

Chip Registers Read/Write Test. The Chip Registers Read/Write Test verifies 

that the registers of each acquisition IC are operating properly. Test patterns are 

written to each register on each acquisition IC, read, and compared with known 

values. The registers are reset, and verified that each register has been initialized. 
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Test patterns are then written to ensure the chip address lines are not shorted or 

opened. Finally test data is written to registers of individual acquisition ICs to 

ensure each acquisition IC can be selected independently.

Passing the Chip Registers Read/Write Test implies that the acquisition IC 

registers can store acquisition control data to properly manage the operating of 

each IC.

Analyzer Chip Memory Bus Test. The Analyzer Chip Memory Bus Test 

verifies the operation of the acquisition memory buses between acquisition ICs. 

After initializing the memory a walking “1” and “0” pattern is created at the 

output of the acquisition ICs. This test data is stored in memory, read, and 

compared with known values.

Passing the Analyzer Chip Memory Bus Test implies that the acquisition memory 

buses between the acquisition ICs and acquisition memory is operating, and that 

acquisition data can propagate from the ICs to memory.

System Clocks (Master/Slave/Psync) Test. The System Clocks (Master/

Slave/Psync) Test verifies the system clock are functional between all boards in a 

master/expander multi-card module. The module is configured for a simple 

measurement and test data is created. The test data is then downloaded and 

compared with known values.

Passing the System Clocks (Master/Slave/Psync) Test implies that the acquisition 

ICs of each expander board of a multi-card configuration can properly receive 

system clocks, and that all acquisition ICs in the multi-card module will properly 

capture data.

Analyzer Memory Bus SU/H Measure. The Analyzer Memory Bus SU/H 

Measure is an internal test that ensures the timing between the acquisition IC and 

acquisition memory is within acceptable parameters.

System Backplane Clock Test. The System Backplane Clock Test verifies the 

100 MHz acquisition system clock. The test also ensures an on-board phase-

locked loop can properly generate multiples of the acquisition system clock 

frequency. The 100 MHz acquisition system clock is first routed directly to the 

acquisition ICs. A timer is initialized, run, and stopped after 100ms. the counter is 

read, and compared with a known value. The acquisition system clock is then 

routed to the phase-locked loop to generate a frequency of 166.7 MHz. Again, the 

counter is initialized, run, and stopped after 100ms. The counter is read, and 

compared with a known value.

Passing the System Backplane Clock Test implies that the system acquisition 

clock is operating, and is within 5% of the desired acquisition frequency.

Inter-chip Resource Bus Test. The Inter-chip Resource Bus Test verifies the 

resource lines that run between each acquisition IC to ensure that the resource 

lines can be both driven as outputs and read as inputs. The resource registers are 
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written with test patterns, read back, then compared with known values. The 

resource registers are then written with test patterns, read back from a different 

acquisition IC, and then compared with known values.

Inter-module Flag Bits Test. Flag bits are used for module-to-module 

communication within the logic analysis system. The Inter-module Flag Bits Test 

verifies that the flag bit lines can be driven and received by each acquisition IC in 

each module. Test patterns are written to the flag registers, read by the other 

acquisition ICs in the other modules, and then compared with known values.

Passing the Inter-module Flag Bits Test implies that the acquisition ICs can 

communicate using Flag Bits through the CPU interface and the logic analysis 

system backplane, and that the operations utilizing the flag bits can be properly 

recognized by all modules in the system.

Global and Local Arm Lines Test. The Global and Local Arm Lines Test 

verifies that the local arm signal can be received by each acquisition IC on the 

master board. The test also verifies the global arm signal can be driven by each 

acquisition IC on a master board, and received by all acquisition ICs in the 

module on the master and on all expander boards. The arm lines are asserted and 

read at the acquisition ICs to ensure each acquisition IC recognizes the signal.

Passing the Global and Local Arm Lines Test implies any acquisition ICs on the 

master board can arm the module, and that all acquisition ICs can recognize the 

arm signal.

EEPROM Test. The EEPROM Test verifies the operation of the module 

EEPROM, which stores the operational accuracy calibration factors. The existing 

contents of the EEPROM are uploaded into system memory. The EEPROM is 

overwritten with test patterns to verify that each cell in the EEPROM can 

independently store a 1 or 0. After the test has completed the original contents of 

the EEPROM are restored and its checksum verified.

Passing the EEPROM Test implies that the current operational accuracy 

calibration factors can be stored and then retrieved for use by the module to 

optimize its performance.

ADC Test. The ADC Test verifies the operation on the module analog-to-digital 

convertor (ADC) used in the module operational accuracy calibration, probe 

adapter identification, and on-board temperature monitoring. The ADC has built-

in test voltage channels which monitors three test voltages. The output of the 

channels is then compared with known values.

Passing the ADC Test implies that the analog-to-digital convertor is operating 

properly and that the data paths around the ADC can properly pass data.

Probe ID Read Test. The Probe ID Read Test verifies that the analog-to-digital 

convertor (ADC) tested above and the on-board digital-to-analog convertor are 

operating to read the probe adapter ID. Probe adapter identification is done using 

www.valuetronics.com



132   

Chapter 5: Troubleshooting

Self-Test Descriptions

a precision resistor. When the probe adapter is installed onto the probe cable, the 

precision resistor completes a voltage divider network. The Probe ID Read Test 

exercises the voltage divider network and then reads the voltage across the 

precision resistor and compares the voltage to know values.

Passing the Probe ID Read Test implies that any of the compatible probe adapters 

can be properly identified, causing the module to configure itself correctly.

Demux Data Arrays Programming Test. The Demux Data Arrays 

Programming Test verifies that the gate arrays’ programming bits can be properly 

configured. Various test patterns are written to the programming port of the gate 

arrays, then read back and compared to expected values.

Passing the Demux Data Arrays Programming Test implied that the gate arrays 

can be programmed according to the operating mode of the module.

Comparators Programming Test. The Comparators Programming Test 

verifies that the comparators’ programming bits can be properly configured. 

Various test patterns are written to the programming port of each comparator, 

then read back and compared to expected values.

Passing the Comparators Programming Test implies that the comparators can be 

programmed according to the operating mode of the module.

Data Path Pass-Thru Test. The Data Path Pass-Thru Test ensures that 

incoming data can flow correctly between the comparators and the acquisition 

ICs. The gate arrays are programmed for low-speed acquisition, which makes 

them invisible to data. The comparators are configured in test mode to drive a 

toggling signal on one of the comparator outputs while all other outputs are held 

quiet. The activity detectors in the acquisition ICs are monitored to verify that 

only the expected signal is toggling. The test is repeated for each comparator 

output.

Passing the Data Path Pass-Thru Test implies that incoming data can flow from 

the module front end to the acquisition ICs without errors for low speed 

acquisition modes (Timing, 200 MHz State, and 400 MHz State acquisition 

modes).

Data Path Demux Test. The Data Path Demux Test operates the same as the 

Data Path Pass-Thru Test, except the gate arrays are programmed for high-speed 

acquisition where the incoming data is demultiplexed to improve throughout.

Passing the Data Path Demux Test implies that incoming data can flow from the 

module front end to the acquisition ICs without errors for high speed acquisition 

modes (800 MHz State and 1250 Mb/s State acquisition modes).

Comparators V Offset Test. The Comparators V Offset Test completes the 

operation check of the comparators. Voltage offset is programmed into the 

comparators to ensure proper signal symmetry of the differential signal with 
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respect to a threshold. The test verifies that the voltage offset can be 

programmed at all points throughout the offset range.

Passing the Comparators V Offset Test implies that the comparator voltage offset 

is programmable to ensure differential data signals are properly captured.

Comparators Calibration Test. The Comparators Calibration Test runs the 

comparator calibration to optimize the performance of the module. Both analog 

and digital domain tests are run to optimize signal integrity in the module front 

end.

Passing the Comparators Calibration Test implies that the comparators are 

completely operational and can be performance optimized. Note that the 

resulting calibration factors are not stored.

LA Chip Calibration Test. The LA Chip Calibration Test ensures that each 

acquisition IC in the module can perform an operational accuracy self-calibration 

every time Run is selected. The module is set in various configurations, after 

which the self-calibration routing is initiated. The results of the self-calibration is 

then checked to see if self-calibration was successful.

Passing the LA Chip Calibration Test implies that the module can reliably perform 

an operation accuracy self-calibration every time Run is selected. Consequently 

the incoming data is optimized to reduce channel-to-channel skew so the 

acquisition ICs can reliably capture the incoming data.
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To exit the test system

On a 16900-Series Mainframe

1 Simply close the self-test window. No additional actions are required.

On a 16700-Series Mainframe

1 Select Close to close any module or system test windows.

2 In the Self Test window, select Quit.

3 In the session manager window, select Start Session to launch a new logic 

analyzer session.
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To test the cables using an E5378A single-ended probe

On a 16900-Series Mainframe

This test allows you to functionally verify the logic analyzer cable and an Agilent 

E5378A probe.

Equipment Required

1 Connect the logic analyzer to the stimulus board:

a Connect an Agilent E5378A 100-pin single-ended probe to the logic 

analyzer module. Connect logic analyzer Pod 1 to the probe output 

marked “Odd.” Connect logic analyzer Pod 2 to the probe output 

marked “Even.”

b Connect the probe input to stimulus board connector Pod 3 (J3, 

800 Mb/s, full speed clock).

c Connect a power cord to the stimulus board power supply. Connect the 

stimulus board power supply output to the stimulus board power 

supply connector J82.

Equipment Critical Specification Recommended Part

Stimulus Board No Substitute 16760-60001
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d Plug in the stimulus power supply into line power. The green LED DS1 

should illuminate showing that the stimulus board is active

2 Set up the stimulus board:

a Configure the oscillator select switch, S1, for an internal 500 MHz clock 

according to the following settings:

• S1 = 0

• S2 = 1

• S3 = 0

• Int

b Configure the data mode switch, S4, according to the following settings:

• Even

• Count

c Press the Resynch VCO button; then, press the Counter RST (Counter 

Reset) button.
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3 In the Agilent Logic Analyzer application, choose “File>New” to put the 

logic analysis system into its initial state.

4 Set up the logic analyzer’s sampling mode and options:

a Click the  Sampling Setup icon.

b Select the “State - Synchronous Sampling” Acquisition mode.

c Set the Trigger Position to “100% poststore”.

d Set the Acquisition Depth to “8K”.

e Select the “800 Mb/s” Sampling Option.

f Make sure the Clock Mode is “Periodic”.

g Select “Rising Edge” for Pod1 Clk1.

h Click “OK” to close the Analyzer Setup dialog.

5 Set up threshold voltages:

a Click the  Bus/Signal Setup icon.

b In the Analyzer Setup dialog’s Buses/Signals tab, click the Threshold 

button for Pod 1.
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c In the Threshold Settings dialog, set the threshold value for Pod 1 of 

the 16760A logic analyzer to “1 V”. Also, check “Apply setting to all 

pods” to properly set the threshold voltage for Pod 2, and uncheck 

“Apply settings to clock bits” (because the clock input threshold will be 

set to “differential” in a later step).

d Click “OK” to close the Threshold Settings dialog.

Now, in the Buses/Signals tab of the Analyzer Setup dialog, the activity 

indicators for Pod 1 show activity.

e Click the “Clock” (Cl) threshold button.

f In the Threshold Settings - Clocks dialog, click the threshold button 

associated with the Pod 1 clock.

g In the Threshold Settings for Pod 1 dialog, select “Differential”.

h Click “OK” to close the Threshold Settings dialogs.

Now, in the Buses/Signals tab of the Analyzer Setup dialog, the activity 

indicator for the Pod 1 clock shows activity.
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6 Set up a bus for the pod’s channels:

a Click the  Bus/Signal Setup icon.

b In the Analyzer Setup dialog’s Buses/Signals tab, assign all Pod 1 

channels to the bus name “My Bus 1”.

c Click “OK” to close the Analyzer Setup dialog.

7 Adjust sampling positions using eye finder:

a Click the  Sampling Setup icon.

b In the Analyzer Setup dialog’s Sampling tab, click “Thresholds and 

Sample Positions...”.

c In the Thresholds and Sample Positions dialog, expand the “My Bus 1” 

bus name so you can see the individual signals in the bus.
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d Click “Run” (the green button in the lower left-hand corner of the 

dialog). If any sample positions (blue bars) are in the wrong eye, drag 

the blue bars into the correct eye, and click “Run” again.

e Click “OK” to close the Thresholds and Sample Positions dialog, and 

click “OK” to close the Analyzer Setup dialog.

8 Acquire and verify data:

a In the Listing window, set up the logic analyzer to trigger My Bus 1 

value “0000”.

b Click the  Run icon.
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The listing should look similar to:

c Scroll down at least 256 states to verify the data.

The My Bus 1 data shows two incrementing binary counters.

If the listing does not look similar the figure, there is a possible problem with 

the cable or high density adapter. Causes for cable test failure include:

• Open channel.

• Channel shorted to a neighboring channel.

• Channel shorted to either ground or a supply voltage.

9 If the test data is not correct, isolate the failure:

a Reconnect probe adapter to the logic analyzer. Connect logic analyzer 

Pod 1 to the probe adapter output marked “Even.” Connect logic 

analyzer Pod 2 to the probe adapter output marked “Odd.”

b Click the  Run icon.

The My Bus 1 data shows two decrementing binary counters.

c Scroll down at least 256 states to verify the data.
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If errors in the test data remain, suspect the logic analyzer cable.

If the errors are gone, suspect the E5378A probe adapter. Reconnect the logic 

analyzer Pod 1 cable to the “Odd” connector on the probe adapter, and 

connect the Pod 2 cable to the “Even” connector. Then, continue with the 

remaining steps to test the Pod 2 cable.

10 Change the logic analyzer pod assignment to use Pod 2:

a Choose “Setup>(logic analyzer module name)>Pod Assignment...”.

b In the Pod Assignment dialog, select “Reserved for time tag storage” for 

Pod 1 and the logic analyzer module name for Pod 2.

c Click “OK” to close the Pod Assignment dialog.
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11 Set up a bus for the pod’s channels:

a Click the  Bus/Signal Setup icon.

b In the Analyzer Setup dialog’s Buses/Signals tab, assign all Pod 2 

channels to the bus name “My Bus 1”.

c Click “OK” to close the Analyzer Setup dialog.

12 Adjust sampling positions using eye finder:

a Click the  Sampling Setup icon.

b In the Analyzer Setup dialog’s Sampling tab, click “Thresholds and 

Sample Positions...”.

c In the Thresholds and Sample Positions dialog, expand the “My Bus 1” 

bus name so you can see the individual signals in the bus.
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d Click “Run” (the green button in the lower left-hand corner of the 

dialog). If any sample positions (blue bars) are in the wrong eye, drag 

the blue bars into the correct eye, and click “Run” again.

e Click “OK” to close the Thresholds and Sample Positions dialog, and 

click “OK” to close the Analyzer Setup dialog.

13 Acquire and verify data:

a In the Listing window, set up the logic analyzer to trigger My Bus 1 

value “0000”.

b Click the  Run icon.
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The listing should look similar to:

c Scroll down at least 256 states to verify the data.

The My Bus 1 data shows two decrementing binary counters.

If the listing does not look similar the figure, there is a possible problem with 

the cable or high density adapter. Causes for cable test failure include:

• Open channel.

• Channel shorted to a neighboring channel.

• Channel shorted to either ground or a supply voltage.

14 If the test data is not correct, isolate the failure:

a Reconnect probe adapter to the logic analyzer. Connect logic analyzer 

Pod 1 to the probe adapter output marked “Even.” Connect logic 

analyzer Pod 2 to the probe adapter output marked “Odd.”

b Click the  Run icon.

The My Bus 1 data shows two incrementing binary counters.

c Scroll down at least 256 states to verify the data.
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If errors in the test data remain, suspect the logic analyzer cable.

If the errors are gone, suspect the E5378A probe adapter. If the problem is 

really in the probe adapter, you should have also seen it when testing the 

Pod 1 cable.

Return to the troubleshooting flowchart.

On a 16700-Series Mainframe

This test allows you to functionally verify the logic analyzer cable and an Agilent 

E5378A probe.

Equipment Required

1 Connect the logic analyzer to the stimulus board.

a Connect an Agilent E5378A 100-pin single-ended probe to the logic 

analyzer module. Connect logic analyzer Pod 1 to the probe output 

marked “Odd.” Connect logic analyzer Pod 2 to the probe output 

marked “Even.”

b Connect the probe input to stimulus board connector Pod 3 (J3, 

800 Mb/s, full speed clock).

c Connect a power cord to the stimulus board power supply. Connect the 

stimulus board power supply output to the stimulus board power 

supply connector J82.

Equipment Critical Specification Recommended Part

Stimulus Board No Substitute 16760-60001
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d Plug in the stimulus power supply into line power. The green LED DS1 

should illuminate showing that the stimulus board is active

2 Set up the stimulus board.

a Configure the oscillator select switch S1 according to the following 

settings:

• S1 Off

• S2 Off

• S3 Off

• Int

b Configure the data mode switch S4 according to the following settings:

• Even

• Count

c Press the Resynch VCO button, then Counter RST (Counter Reset) 

button.
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3 Set up the logic analyzer

a Open the Session Manager window and select “Start Session.”

b In the logic analyzer system window, select the module icon, then select 

Setup and Trigger. A Setup and Trigger window appears.

c In the logic analysis system window, select the module icon, then select 

Listing. A Listing window appears.

4 Set up the Sampling tab:

a In the logic analyzer Setup and Trigger window, select the Sampling tab.

b Under the Sampling tab, select State Mode.

c Select the clock edge field for J-clock, then select Rising Edge.

5 Configure the Trigger settings

a In the logic analyzer Setup and Trigger window, select the Trigger tab.

b Under the Trigger tab, select the Settings tab.

c Select the Acquisition Depth field, then select 8K.

d Select the Trigger Position field, then select Start.
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e Select the Count field, then select Off.

6 Configure the Format tab

a In the logic analyzer Setup and Trigger window, select the Format tab.

b Under the Format tab, select Pod Assignment.

c In the Pod Assignment window, use the mouse to drag the pods to the 

Analyzer 1 column.

d Select Close to close the pod assignment window.
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e Under the Format tab, select the field showing the channel assignments 

for one of the pods being tested, then select “****************” to 

active all channels.

f Select OK to close the channel assignment window.

g Repeat e and f for the remaining pods to be tested.

7 Configure the logic analyzer thresholds

a In the logic analyzer Setup and Trigger window, select the Format tab.

b Under the Format tab, select the threshold field under either pod. The 

Pod threshold window will appear.

c In the Pod threshold window, ensure the Apply threshold setting to all 

pods is checked.

www.valuetronics.com



 151

Chapter 5: Troubleshooting

To test the cables using an E5378A single-ended probe

d In the Pod threshold window, select User Defined, then select the 

threshold voltage field. Enter 1.00V.

e Select Close to close the pod threshold window.

f Under the Format tab, select the Clk Thresh... field. The clock 

threshold window will appear.

g Select the threshold field associated with J-clock. The J threshold 

window will appear.

h In the J threshold window, select Differential.

i Select Close to close the J threshold window, then select Close to close 

the Clock threshold window.
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8 On the logic analyzer, select Run. The listing should look similar to the 

figure below.

Scroll down at least 256 states to verify the data. The lower two bytes (four 

digits) of Label1 show two incrementing binary counters. The upper two bytes of 

Label1 show two decrementing binary counters. If the listing does not look 

similar the figure, then there is a possible problem with the cable or high density 

adapter. Causes for cable test failure include:

• Open channel.

• Channel shorted to a neighboring channel.

• Channel shorted to either ground or a supply voltage.

If the test data on either the lower two bytes or the upper two bytes is not 

correct, then perform the following step to isolate the failure.

9 Verify the failure

a Reconnect probe adapter to the logic analyzer module. Connect logic 

analyzer Pod 1 to the probe adapter output marked “Even.” Connect 

logic analyzer Pod 2 to the probe adapter output marked “Odd.”
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b On the logic analyzer, select Run. Note the lower two bytes now 

displays two decrementing counters, the upper two bytes displays two 

incrementing counters.

If the error in the test data remains the same two bytes as the previous run 

(that is, the error follows the cable) then the cable is suspect.

If the error is now in the opposite two bytes (that is, the error follows the 

E5378A probe adapter) the probe adapter is suspect.

Return to the troubleshooting flowchart.
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To test the cables using E5379A differential probes

On a 16900-Series Mainframe

This test allows you to functionally verify the logic analyzer cables and Agilent 

E5379A probes.

Equipment Required

1 Connect the logic analyzer to the stimulus board:

a Connect one Agilent E5379A 100-pin differential probe to the logic 

analyzer Pod 1 cable to be tested. Then, connect the probe input to the 

stimulus board connector Pod 3 (J3, 800 Mb/s, full speed clock).

b Connect another Agilent E5379A 100-pin differential probe to the logic 

analyzer Pod 2 cable to be tested. Then, connect the probe input to the 

stimulus board connector Pod 4 (J4, 800 Mb/s, half speed clock).

c Connect a power cord to the stimulus board power supply. Connect the 

stimulus board power supply output to the stimulus board power 

supply connector J82.

Equipment Critical Specification Recommended Part

Stimulus Board No Substitute 16760-60001
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d Plug in the stimulus power supply into line power. The green LED DS1 

should illuminate showing that the stimulus board is active

2 Set up the stimulus board:

a Configure the oscillator select switch S1 for an internal 500 MHz clock 

according to the following settings:

• S1 = 0

• S2 = 1

• S3 = 0

• Int

b Configure the data mode switch S4 according to the following settings:

• Even

• Count

c Press the Resynch VCO button; then, press the Counter RST (Counter 

Reset) button.

3 In the Agilent Logic Analyzer application, choose “File>New” to put the 

logic analysis system into its initial state.
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4 Set up the logic analyzer’s sampling mode and options:

a Click the  Sampling Setup icon.

b Select the “State - Synchronous Sampling” Acquisition mode.

c Set the Trigger Position to “100% poststore”.

d Set the Acquisition Depth to “8K”.

e Select the “800 Mb/s” Sampling Option.

f Make sure the Clock Mode is “Periodic”.

g Select “Rising Edge” for Pod1 Clk1.

h Click “OK” to close the Analyzer Setup dialog.

5 When E5479A differential probes are detected, pod and clock thresholds 

are set to “Differential” automatically (so you do not have to perform the 

step of setting up thresholds).
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6 Set up a bus for the pod’s channels:

a Click the  Bus/Signal Setup icon.

b In the Analyzer Setup dialog’s Buses/Signals tab, assign all Pod 1 

channels to the bus name “My Bus 1”.

c Click “OK” to close the Analyzer Setup dialog.

7 Adjust sampling positions using eye finder:

a Click the  Sampling Setup icon.

b In the Analyzer Setup dialog’s Sampling tab, click “Thresholds and 

Sample Positions...”.

c In the Thresholds and Sample Positions dialog, expand the “My Bus 1” 

bus name so you can see the individual signals in the bus.
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d Click “Run” (the green button in the lower left-hand corner of the 

dialog). If any sample positions (blue bars) are in the wrong eye, drag 

the blue bars into the correct eye, and click “Run” again.

e Click “OK” to close the Thresholds and Sample Positions dialog, and 

click “OK” to close the Analyzer Setup dialog.

8 Acquire and verify data:

a In the Listing window, set up the logic analyzer to trigger My Bus 1 

value “0000”.

b Click the  Run icon.
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The listing should look similar to:

c Scroll down at least 256 states to verify the data.

The My Bus 1 data shows two decrementing binary counters.

If the listing does not look similar the figure, there is a possible problem with 

the cable or high density adapter. Causes for cable test failure include:

• Open channel.

• Channel shorted to a neighboring channel.

• Channel shorted to either ground or a supply voltage.

9 If the test data is not correct, isolate the failure:

a Swap the E5379A probe adapters. Make sure that the Pod 1 cable 

remains connected to stimulus board J3 and that the Pod 2 cable 

remains connected to stimulus board J4.

b Click the  Run icon.

c Scroll down at least 256 states to verify the data.

If errors in the test data are still there, suspect the logic analyzer cable.

www.valuetronics.com



160   

Chapter 5: Troubleshooting

To test the cables using E5379A differential probes

If the errors are gone, suspect the E5379A probe adapter. Return the probe 

adapters to their original logic analyzer cable and stimulus board connections. 

Then, continue with the remaining steps to test the Pod 2 cable.

10 Change the logic analyzer pod assignment to use Pod 2:

a Choose “Setup>(logic analyzer module name)>Pod Assignment...”.

b In the Pod Assignment dialog, select “Reserved for time tag storage” for 

Pod 1 and the logic analyzer module name for Pod 2.

c Click “OK” to close the Pod Assignment dialog.
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11 Set up a bus for the pod’s channels:

a Click the  Bus/Signal Setup icon.

b In the Analyzer Setup dialog’s Buses/Signals tab, assign all Pod 2 

channels to the bus name “My Bus 1”.

c Click “OK” to close the Analyzer Setup dialog.

12 Adjust sampling positions using eye finder:

a Click the  Sampling Setup icon.

b In the Analyzer Setup dialog’s Sampling tab, click “Thresholds and 

Sample Positions...”.

c In the Thresholds and Sample Positions dialog, expand the “My Bus 1” 

bus name so you can see the individual signals in the bus.
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d Click “Run” (the green button in the lower left-hand corner of the 

dialog). If any sample positions (blue bars) are in the wrong eye, drag 

the blue bars into the correct eye, and click “Run” again.

e Click “OK” to close the Thresholds and Sample Positions dialog, and 

click “OK” to close the Analyzer Setup dialog.

13 Acquire and verify data:

a In the Listing window, set up the logic analyzer to trigger My Bus 1 

value “0000”.

b Click the  Run icon.
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The listing should look similar to:

c Scroll down at least 256 states to verify the data.

The My Bus 1 data shows two decrementing binary counters.

If the listing does not look similar the figure, there is a possible problem with 

the cable or high density adapter. Causes for cable test failure include:

• Open channel.

• Channel shorted to a neighboring channel.

• Channel shorted to either ground or a supply voltage.

14 If the test data is not correct, isolate the failure:

a Swap the E5379A probe adapters. Make sure that the Pod 1 cable 

remains connected to stimulus board J3 and that the Pod 2 cable 

remains connected to stimulus board J4.

b Click the  Run icon.

c Scroll down at least 256 states to verify the data.

If errors in the test data remain, suspect the logic analyzer cable.
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If the errors are gone, suspect the E5379A probe adapter. If the problem is 

really in the probe adapter, you should also be able to see it when testing the 

Pod 1 cable.

Return to the troubleshooting flowchart.

On a 16700-Series Mainframe

This test allows you to functionally verify the logic analyzer cable and an Agilent 

E5379A probe.

Equipment Required

1 Connect the logic analyzer to the stimulus board.

a Connect an Agilent E5379A 100-pin differential probe to the logic 

analyzer cable to be tested.

b Connect the probe input to the stimulus board connector Pod 3 (J3, 

800 Mb/s, full speed clock).

c Connect a power cord to the stimulus board power supply. Connect the 

stimulus board power supply output to the stimulus board power 

supply connector J82.

Equipment Critical Specification Recommended Part

Stimulus Board No Substitute 16760-60001
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d Plug in the stimulus power supply into line power. The green LED DS1 

should illuminate showing that the stimulus board is active.

2 Set up the stimulus board

a Configure the oscillator select switch S1 according to the following 

settings:

• S1 Off

• S2 Off

• S3 Off

• Int

b Configure the data mode switch S4 according to the following settings:

• Even

• Count

c Press the Resynch VCO button, then the Counter RST (Counter Reset) 

button.
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3 Set up the logic analyzer

a Open the Session Manager window and select “Start Session.”

b In the Logic Analysis System window, select the module icon, then 

select Setup and Trigger. A Setup and Trigger window appears.

c In the Logic Analysis System window, select the module icon, then 

select Listing. A Listing window appears.

4 Set up the Sampling tab

a In the logic analyzer Setup and Trigger window, select the Sampling tab.

b Under the Sampling tab, select State Mode.

c Select the clock edge field for J-clock, then select Rising Edge.

5 Configure the Trigger settings

a In the logic analyzer Setup and Trigger window, select the Trigger tab.

b Under the Trigger tab, select the Settings tab.

c Select the Acquisition Depth field, then select 8K.

d Select the Trigger Position field, then select Start.
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e Select the Count field, then select Off.

6 Configure the Format tab

a In the logic analyzer Setup and Trigger window, select the Format tab.

b Under the Format tab, select Pod Assignment.

c In the Pod Assignment window, use the mouse to drag the pod under 

test to the Analyzer 1 column.

d Select Close to close the pod assignment window.
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e Under the Format tab, select the field showing the channel assignment 

for the pod under test, then select “****************” to activate all 

channels.

f Select OK to close the channel assignment window.

7 Configure the logic analyzer thresholds

a Under the Format tab, select the CLK Thresh... field. The Clock 

threshold window will appear.

b Select the threshold field associated with J-clock. The J threshold 

window will appear.

c In the J threshold window, select Differential.

d Select Close to close the J threshold window, then select Close to close 

the Clock threshold window.
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8 On the logic analyzer, select Run. The listing should look similar to the 

figure below.

Scroll down at least 256 states to verify the data. Label1 shows two decrementing 

binary counters. If the listing does not look similar to the figure, then there is a 

possible problem with the cable or high density probe adapter. Cause for cable 

test failures include:

• open channel

• channel shorted to a neighboring channel

• channel shorted to either ground or a supply voltage

If the test data is not correct, then perform the following step to isolate the 

failure.

9 Verify the failure

a Reconnect probe adapter to the other logic analyzer cable.

b Repeat step 6 through 8 to reconfigure the Format tab in the Setup and 

Trigger window. Deactivate the pod just tested. Activate the pod to be 

tested and assign all channels to Label1.

c On the logic analyzer, select Run. The expected test data is the same as 

in step 8 above.

If the test data is now correct (that is, the error follows the cable) then the 

cable is suspect.
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If the test data is still not correct (that is, the error follows the E5379A probe 

adapter) the probe adapter is suspect.

Return to the troubleshooting flowchart.
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Replacing Assemblies

This chapter contains the instructions for removing and replacing the logic 

analyzer module, the circuit board of the module, and the probe cables of the 

module as well as the instructions for returning assemblies.
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CAUTION: Turn off the instrument before installing, removing, or replacing a module in the 

instrument.

CAUTION: Electrostatic discharge can damage electronic components. Use grounded wrist-

straps, mats, and standard ESD precautions when you perform any service to the 

mainframe or the modules in it.

Tools Required

• A T10 TORX screwdriver, to remove screws connecting the probe cables and 

screws connecting the back panel.

To remove the module

Instructions for removing or installing the module into the mainframe can be 

found in the installation guide for the mainframe.

If you don’t have the installation guide for your mainframe, you can find the latest 

version on the Internet at www.agilent.com.

For example: to find the installation guide for a 16700B mainframe, go to 

www.agilent.com and enter “16700B installation guide” in the quick search box. 

Then, scroll down to “Manuals, Guides & Notifications” to find the 16700B-Series 

Logic Analysis Systems Installation Guide.
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To remove the logic analyzer cable

1 Remove power from the instrument

a Exit all logic analysis session. In the session manager, select Shutdown.

b At the query, select Power Down.

c When the “OK to power down” message appears, turn the instrument 

off.

d Disconnect the power cord.

2 Remove the logic analyzer cable clamp.

a Remove two screws that secure the top logic analyzer cable clamp to 

the outside rear panel.

b Remove two screws that secure the top cable clamp to the inside rear 

panel.

c Slide the top cable clamp out of the rear panel.

3 Remove the logic analyzer cable.

a Gently lift the logic analyzer cable end connector from the circuit board 

connector (J1 or J2).

b Remove the logic analyzer cable end connector through the rear panel. 

The bottom cable clamp will also be removed with the logic analyzer 

cable.

4 If the logic analyzer cable is faulty, replace the cable and follow the next 

procedure to install the replacement logic analyzer cable.
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To install the logic analyzer cable

1 Connect the logic analyzer cable to the logic analyzer circuit board.

a Insert the logic analyzer cable to the logic analyzer circuit board.

b Align the logic analyzer cable end connector with the circuit board 

cable connector (J1 or J2) and gently apply pressure to seat the logic 

analyzer cable onto the circuit board connector.

c Insert the top and bottom logic analyzer cable clamps into the rear 

panel.

2 Secure the cable clamp to the rear panel.

a Install the two longer screws (H5) vertically through the top cable 

clamp into both the bottom cable clamp and the circuit board. Do not 

tighten the screws yet.
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b Install the two shorter screws (H4) through the rear of both cable 

clamps into the rear panel. Do not tighten the screws yet.

c Tighten the short rear panel cable clamp screws (H4) to 5 in/lb. Then 

tighten the longer cable clamp screws (H5) to 5 in/lb.

CAUTION: If you over tighten the screws, the threaded inserts on the rear panel, the 

threaded inserts on the circuit board, or the cable clamp itself might break. 

Tighten the screws only enough to hold the cable in place, approximately 5 in/lb.
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To replace the circuit board

1 Remove both logic analyzer cables using the “To remove the logic analyzer 

cable” procedure on page 173.

2 Remove the four screws attaching the ground spring and back panel to the 

circuit board, then remove the back panel and the ground spring.

3 Replace the faulty circuit board with a new circuit board. On the faulty 

board, make sure the 20-pin ribbon cable is connected between J3 and J6.

4 Position the ground spring and back panel on the back edge of the 

replacement circuit board. Install four screws to connect the back panel 

and ground spring to the circuit board.

5 Install both logic analyzer cables using the procedure “To install the logic 

analyzer cable” on page 174.
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To return assemblies

Before shipping the module to Agilent Technologies, contact your nearest Agilent 

Technologies Sales Office for additional details. Information on contacting Agilent 

can be found at http://www.agilent.com.

1 Write the following information on a tag and attach it to the module.

• Name and address of owner.

• Model number.

• Serial number.

• Description of service required or failure indications.

2 Remove accessories from the module.

Only return accessories to Agilent Technologies if they are associated with the 

failure symptoms.

3 Package the module.

You can use either the original shipping containers, or order materials from an 

Agilent Technologies sales office.

CAUTION: For protection against electrostatic discharge, package the module in 

electrostatic material.

4 Seal the shipping container securely, and mark it FRAGILE.
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Replaceable Parts

This chapter contains information for identifying and ordering replaceable parts 

for your module.

www.valuetronics.com



180   

Chapter 7: Replaceable Parts

Replaceable Parts Ordering

Parts listed

To order a part on the list of replaceable parts, quote the Agilent Technologies 

part number, indicate the quantity desired, and address the order to the nearest 

Agilent Technologies Sales Office.

Parts not listed

To order a part not on the list of replaceable parts, include the model number and 

serial number of the module, a description of the part (including its function), 

and the number of parts required. Address the order to your nearest Agilent 

Technologies Sales Office.

Direct mail order system

To order using the direct mail order system, contact your nearest Agilent 

Technologies Sales Office.

Within the USA, Agilent Technologies can supply parts through a direct mail 

order system. The advantages to the system are direct ordering and shipment 

from the Agilent Technologies Part Center in Mountain View, California. There is 

no maximum or minimum on any mail order. (There is a minimum amount for 

parts ordered through a local Agilent Technologies Sales Office when the orders 

require billing and invoicing.) Transportation costs are prepaid (there is a small 

handling charge for each order) and no invoices.

In order for Agilent Technologies to provide these advantages, a check or money 

order must accompany each order. Mail order forms and specific ordering 

information are available through your local Agilent Technologies Sales Office. 

Addresses and telephone numbers are located in a separate document shipped 

with the Agilent Technologies 16900-Series (or 16700-Series) Logic Analysis 

System Service Manual.

Exchange assemblies

Some assemblies are part of an exchange program with Agilent Technologies.

The exchange program allows you to exchange a faulty assembly with one that 

has been repaired and performance verified by Agilent Technologies.

After you receive the exchange assembly, return the defective assembly to 

Agilent Technologies. A United States customer has 30 days to return the 

defective assembly. If you do not return the defective assembly within the 30 

days, Agilent Technologies will charge you an additional amount. This amount is 

the difference in price between a new assembly and that of the exchange 

assembly. For orders not originating in the United States, contact your nearest 
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Agilent Technologies Sales Office for information.

See Also “To return assemblies” on page 177.

Replaceable Parts List

The replaceable parts list is organized by reference designation and shows 

exchange assemblies, electrical assemblies, then other parts.

Information included for each part on the list consists of the following:

• Reference designator.

• Agilent Technologies part number.

• Total quantity included with the module (Qty).

• Description of the part.

Reference designators used in the parts list are as follows:

• A Assembly.

• H Hardware.

• J Connector.

• MP Mechanical Part.

• W Cable.
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Replaceable Parts

Ref. Des. Agilent Part Number QTY Description

Exchange Assemblies

16760-69516 Exchange Acquisition Board Assembly

Replacement Assemblies

A1 16760-66516 1 Acquisition Board Assembly

H1 16500-22401 2 Panel Screw

H2 16500-29101 1 Ground Spring

H3 0510-0684 2 Retaining Ring

H4 0515-0372 4 M3.0x0.5 8mm T10 (Cable Clamp to Rear Panel)

H5 0515-0375 4 M3.0x0.5 16mm T10 (Cable Clamp to Acquisition 

Board)

H6 0515-0430 3 MSPH M3.0x0.50 6mm T10 (Rear Panel to Acquisition 

Board)

MP1 01650-94312 1 Label Set - Probe and Cable

MP2 16760-44107 1 Rear Panel

MP3 16760-44108 4 Logic Analyzer Cable Clamp (two clamps per cable)

MP4 16760-94309 1 Module ID Label

W1 16555-61605 1 Cable (2x20)

W2 16715-60001 1 Master/Expander Cable Kit

W3 16760-61601 2 Logic Analyzer Cable

Accessories for Connectivity to the System Under Test

E5379A Differential Probe

E5378A Single-Ended Probe, 100-pin

E5380A Single-Ended Probe, 38-pin

E5382A Flying Lead Probe

E5381A Differential Flying Lead Probe Set

E5386A Half-channel Adapter

E5387A Differential Soft Touch Connectorless Probe

E5390A Single-ended Soft Touch Connectorless Probe

1253-3620 Samtec Connector

16760-02302 Shroud for 0.062” PC Boards

16760-02303 Shroud for 0.120” PC Boards

16760-68702 *Shroud/Connector Kit for 0.062” PC Boards

16760-68703 *Shroud/Connector Kit for 0.120” PC Boards

1252-7431 MICTOR Connector

E5346-44703 MICTOR Shroud for 0.170” PC Boards

E5346-44704 MICTOR Shroud for 0.125” PC Boards

E5346-68700 *Shroud/Connector Kit for 0.125” PC Boards

*Shroud/Connector kits include connectors (Qty 5) and shrouds (Qty 5) for the indicated system under test circuit board thickness.
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Exploded View

Exploded view of the 16760A logic analyzer
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E5382A Accessories

The following figure shows the accessories supplied with the E5382A Single-

ended Flying Lead Probe Set.

Accessories supplied

The following table shows the part numbers for ordering replacement parts and 

additional accessories.

Replaceable Parts and Additional Accessories

Description Qty Agilent Part Number

Probe Pin Kit 4 16517-82107

High Frequency Probing Kit (4 resistive signal pins & 4 solder-

down grounds)

8 16517-82104

Ground Extender 20 16517-82105

Grabber Clip Kit 20 16517-92109

Right-angle Ground Lead 20 16517-82106

Cable - Main 1 E5382-61601

Probe Tip to BNC Adapter 1 E9638A
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Theory of Operation

This chapter presents the theory of operation for the logic analyzer module and 

describes the self-tests. 
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The information in this chapter is to help you understand how the module 

operates and what the self-tests are testing. This information is not intended for 

component-level repair. 

Block-Level Theory

The block-level theory of operation is divided into two parts: theory for the logic 

analyzer used as a single-card module or as a master card in a multi-card module, 

and theory for the logic analyzer used as an expander card in a multi-card 

module. A block diagram is shown before each theory.

The 16760A logic analyzer

Probe Adapter and Pods. Each pod includes 17 differential channels of 

analysis data, a threshold voltage input, two serial I2C lines for adapter probe 

identification, and 50 ground signals. The 17 differential channels of are fed from 

the probe adapter into the logic analyzer cable (pod) input. For signal-ended 

operation, the negative side of each of the 17 differential signals is coupled to 

ground inside the single-ended probe adapter.

On the end of the Samtec probe adapter is a 100-pin application-specific Samtec 
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connector. The mate to this Samtec connector must be designed into and 

installed in the system under test. Analysis of single-ended or differential signals 

is performed depending on whether the single-ended or differential probe 

adapter is used.

A Mictor-compatible probe adapter is also available. Like the Samtec probe 

adapter, the Mictor probe adapter is used for single-ended signal analysis through 

a Mictor connector designed in and installed into a system under test. Note that 

the performance of the logic analyzer module is limited when a Mictor-compatible 

probe adapter is used.

A threshold voltage input is provided through the probe adapter and pod for the 

user to configure the logic analyzer threshold voltage using the threshold voltage 

of the system under test. The logic analyzer module will then utilize the threshold 

voltage input to determine the logic high and logic low state of the incoming 

signals. The logic analysis system user interface allows the user to select the 

threshold voltage input. The threshold voltage input is designed with safeguards 

to protect the logic analyzer module from destructive effect of electro-static 

discharge (ESD).

The serial I2C lines are used to communicate with the probe adapter for 

identification. Periodic polling allows hot insertion of the probe adapter to the 

16760A pod. When the probe adapter is installed at the end of the pod, the logic 

analyzer module polls the ID of the probe adapter. The module then configures 

itself for either single-ended or differential signal analyzer. The serial I2C lines 

are also designed with ESD safeguards.

The pods provide a 5 Vdc +5% auxiliary power to the end of the cable. A thermal 

protection circuit senses any over-current and automatically disables the 

auxiliary power. The auxiliary power circuit is designed wit safeguards to protect 

the logic analyzer module from the effects of electro-mechanical interference 

(EMI). Diatonically, a voltage ramp circuit allows an analysis probe to be hot 

inserted onto the end of the pod cable. Note that there are currently no analysis 

probes or other accessories utilizing this auxiliary power that are designed for the 

16760A logic analyzer module as of the printing of this service manual.

Comparators. The comparators are differential input/differential output devices 

that interpret the incoming data and clock signals as either high or low. Threshold 

voltage, programmed by the user through the user interface, is set by a digital-to-

analog converter (DAC) coupled to the negative side of the differential signal 

through a precision resistor. There are separate DAC-driven threshold voltages 

for the data and for the clock. In addition, the comparator contains a diode in 

which the junction temperature is monitored to ensure the module is being 

properly cooled.

Much of the performance optimization for the module is accomplished by the 

comparators, including channel delay setting (EyeFinder), programming of input 

resistance, and frequency compensation adjustment. Module operation such as 
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state clock modes and configuration are also done by the comparators. A digital-

to-analog convertor (DAC) provides the module threshold voltage for single-

ended operation. The voltage at the DAC outputs are buffered to prove sufficient 

line drive. An analog switch is used to channel either the module threshold 

voltage from the DAC or the threshold voltage input from the system under test 

to the comparators.

High Speed Gate Array. The high speed gate arrays sample the incoming data 

in the high speed state modes. The gate arrays have differential inputs and single-

ended outputs and translate the incoming data from differential to single-ended 

signals. The output of the high speed gate arrays is channeled to the input of the 

acquisition ICs. A synchronizing signal ensures the gate arrays sample the data in 

step. A programming interface configures the operation of the gate arrays. In 

addition, each gate array device contains a diode in which the junction 

temperature is monitored to ensure the module is being cooled properly.

Acquisition IC. Each acquisition circuit is made up of a single acquisition IC. 

Each acquisition IC functions as a 17-channel state/timing logic analyzer. Two 

acquisition ICs are included on every single logic analyzer card for a total of 32 

data channels and 2 clock/data channels. All of the sequencing, storage 

qualification, pattern/range recognition and even counting functions are 

performed by the acquisition IC.

The acquisition ICs perform master clocking functions. The state acquisition 

clock is sent to each acquisition IC, and the acquisition ICs generate their own 

sample clock. Every time the user selects RUN, the acquisition ICs individually 

perform a clock optimization before data is stored. Clock optimization involves 

using programmable delays in the acquisition ICs to position the master sampling 

clock transition where valid data is captured. This procedure reduces the effects 

of channel-to-channel skew and other propagation delays.

In timing acquisition mode, a 100 MHz backplane clock from the logic analysis 

system mainframe drives the sample rate of the acquisition ICs. A master 

acquisition IC monitors the RUN signal asserted based on user input. The master 

acquisition IC then gates the sample clocks to all other acquisition ICs in the 

module.

Acquisition memory. The acquisition memory is a bank of 16-bit SDRAM 

devices and stores the processed data from the acquisition IC. Acquisition 

memory input/output is controlled by a memory controller, a bank of field 

programmable gate arrays (FPGA). The memory controller is initialized when 

power is applied to the logic analysis system from files stored on the system hard 

disk drive. During normal operation of the module, then memory controller is 

reprogrammed based on configuration of the module from user input. a second 

initialization file is loaded into the memory controller when the performance 

verification software is loaded into the system.
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CPU Interface. The CPU interface is a programmable logic device that converts 

the bus signals generated by the microprocessor on the mainframe CPU card into 

control signals for the logic analyzer module. All functions of the state and timing 

module can be controlled from the backplane of the mainframe system including 

storage qualification, sequencing, assigning clock edges, RUN and STOP, and 

thresholds. Data transfer between the logic analyzer cards and the mainframe 

CPU is also accomplished through the CPU interface.

Master/Expander Configuration

Connectors J3 and J8 route clock and signals for operational accuracy calibration 

to expander boards in a master/expander multicard module. The master-

configured module has the common connector (J3) cabled to the master 

connector (J6) expander board have their common connector cabled to the 

expander connectors (J4, J5, J7, and J8) of the master-configured board. Clock 

signals generated from either the master acquisition IC (timing mode) or from 

the system under test (state mode) are distributed to the expander boards 

through the master/expander star connectors. Clock generation is disabled to all 

expander boards. Additionally, a pattern found signal is routed from all 

configured expander boards to the master board through the star connectors. 

When the module is in pattern search mode, the pattern found signal is asserted 

by the expander board with the found pattern.
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Connectors J9, J10, J500, and J501 form and acquisition IC pattern resource bus.

In addition to the master board, identification and operational configuration of 

the expander boards are done through the CPU interface.
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Safety 
Notices

This apparatus has been 
designed and tested in accor-
dance with IEC Publication 1010, 
Safety Requirements for Mea-
suring Apparatus, and has been 
supplied in a safe condition.  
This is a Safety Class I instru-
ment (provided with terminal for 
protective earthing).  Before 
applying power, verify that the 
correct safety precautions are 
taken (see the following warn-
ings).  In addition, note the exter-
nal markings on the instrument 
that are described under "Safety 
Symbols."

Warnings

• Before turning on the instru-
ment, you must connect the pro-
tective earth terminal of the 
instrument to the protective con-
ductor of the (mains) power 
cord. The mains plug shall only 
be inserted in a socket outlet 
provided with a protective earth 
contact. You must not negate the 
protective action by using an 
extension cord (power cable) 
without a protective conductor 
(grounding).  Grounding one con-
ductor of a two-conductor outlet 
is not sufficient protection.

• Only fuses with the required 
rated current, voltage, and spec-
ified type (normal blow, time 
delay, etc.) should be used.  Do 
not use repaired fuses or short-
circuited fuseholders.  To do so 
could cause a shock or fire haz-
ard.

• If you energize this instrument 
by an auto transformer (for volt-
age reduction or mains isola-
tion), the common terminal must 
be connected to the earth termi-
nal of the power source.

• Whenever it is likely that the 
ground protection is impaired, 
you must make the instrument 
inoperative and secure it against 
any unintended operation.

• Service instructions are for 
trained service personnel. To 
avoid dangerous electric shock, 
do not perform any service 
unless qualified to do so.  Do not 
attempt internal service or 
adjustment unless another per-
son, capable of rendering first 
aid and resuscitation, is present.

• Do not install substitute parts 
or perform any unauthorized 
modification to the instrument.

• Capacitors inside the instru-
ment may retain a charge even if 
the instrument is disconnected 
from its source of supply.

• Do not operate the instrument 
in the presence of flammable 
gasses or fumes.  Operation of 
any electrical instrument in such 
an environment constitutes a 
definite safety hazard.

• Do not use the instrument in a 
manner not specified by the 
manufacturer.

To clean the instrument

If the instrument requires clean-
ing: (1) Remove power from the 
instrument. (2) Clean the exter-
nal surfaces of the instrument 
with a soft cloth dampened with 
a mixture of mild detergent and 
water. (3) Make sure that the 
instrument is completely dry 
before reconnecting it to a 
power source.

Safety Symbols

Instruction manual symbol:  the 
product is marked with this sym-
bol when it is necessary for you 
to refer to the instruction man-
ual in order to protect against 
damage to the product.

Hazardous voltage symbol.

Earth terminal symbol: Used to 
indicate a circuit common con-
nected to grounded chassis.

!

Agilent Technologies
P.O. Box 2197
1900 Garden of the Gods Road
Colorado Springs, CO 80901
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No part of this manual may be 
reproduced in any form or by any 
means (including electronic 
storage and retrieval or translation 
into a foreign language) without 
prior agreement and written 
consent from Agilent 
Technologies, Inc. as governed by 
United States and international 
copyright laws.

Manual Part Number
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Print History
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Restricted Rights Legend

If software is for use in the per-
formance of a U.S. Government 
prime contract or subcontract, 
Software is delivered and 
licensed as “Commercial com-
puter software” as defined in 
DFAR 252.227-7014 (June 1995), 
or as a “commercial item” as 
defined in FAR 2.101(a) or as 
“Restricted computer software” 
as defined in FAR 52.227-19 
(June 1987) or any equivalent 
agency regulation or contract 
clause. Use, duplication or dis-
closure of Software is subject to 
Agilent Technologies’ standard 
commercial license terms, and 
non-DOD Departments and 
Agencies of the U.S. Govern-
ment will receive no greater than 
Restricted Rights as defined in 
FAR 52.227-19(c)(1-2) (June 
1987). U.S. Government users 
will receive no greater than Lim-
ited Rights as defined in FAR 
52.227-14 (June 1987) or DFAR 
252.227-7015 (b)(2) (November 
1995), as applicable in any tech-
nical data.

Document Warranty

The material contained in 
this document is provided 
“as is,” and is subject to 
being changed, without 
notice, in future editions. 
Further, to the maximum 
extent permitted by applica-
ble law, Agilent disclaims 
all warranties, either 
express or implied, with 
regard to this manual and 
any information contained 
herein, including but not lim-
ited to the implied warran-
ties of merchantability and 
fitness for a particular pur-
pose. Agilent shall not be 
liable for errors or for inci-
dental or consequential 
damages in connection with 
the furnishing, use, or perfor-
mance of this document or of 
any information contained 
herein. Should Agilent and 
the user have a separate 
written agreement with war-
ranty terms covering the 
material in this document 
that conflict with these 
terms, the warranty terms in 
the separate agreement 
shall control.

Technology Licenses 

The hardware and/or software 
described in this document are 
furnished under a license and 
may be used or copied only in 
accordance with the terms of 
such license.

WARNING

A WARNING notice 
denotes a hazard. It calls 
attention to an operating 
procedure, practice, or 
the like that, if not 
correctly performed or 
adhered to, could result 
in personal injury or 
death. Do not proceed 
beyond a WARNING 
notice until the indicated 
conditions are fully 
understood and met.

CAUTION

A CAUTION notice 
denotes a hazard. It calls 
attention to an operating 
procedure, practice, or 
the like that, if not 
correctly performed or 
adhered to, could result in 
damage to the product or 
loss of important data. Do 
not proceed beyond a 
CAUTION notice until the 
indicated conditions are 
fully understood and met. 
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